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Introduction
Yes, I know. There are a lot of books out there that talk about Windows 98.
Few of these are really user-friendly and written in a way that makes learning
fun and easy. If you have found one that you like, please take a few minutes to
share the title with me as I would love to know about it. My attempt here is to
help the novice understand some of the power of Windows 98 while getting
started with the basics.
Although there are differences between Windows 95 and Windows 98, a lot of
the differences are under the covers and should not make any difference for the
casual user. My attempt here is to cover what Windows 98 looks and feels like.
If you know of an important feature I fail to mention, please let me know.
This manual provides information about Windows 98. It starts with a
description of the appearance of Windows 98 and how to control the look and
feel of the system. It then goes on to actually running programs. Locating
information on the system is important, so My Computer, the Windows
Explorer and the Find function will be addressed. Several applets, or miniapplications, come standard with Windows 98, and each of these will be
introduced.
No attempt is made to cover all the details of Windows 98 as the system is
much too complex to be properly addressed here. The reader will become quite
familiar with a number of aspects of Windows 98 while exploring this manual
however.
The primary focus of this manual will be on those features of Windows 98 that
will allow the reader to become productive using Windows 98 without having
to worry about the operating system.
Although the emphasis here is on the Windows 98 operating system itself,
perhaps I should at least say a few words about the mouse as this is your
primary tool for controlling the system. You can do a lot of things in Windows
98 without the mouse, but to really be productive, you will need to use the
mouse. Before I go any further, let me say that the mouse is not something you
talk into. I know of several people who will swear at their mouse when it
doesn't do what they want, but you can't control the system by talking into it.
The mouse is a pointing device that allows you to select things in Windows 98.
Don't be afraid of it. Put your hand firmly on the mouse and keep two fingers
on top ready to press the left or right mouse button. When you get the mouse
where you want on the screen, press down on the mouse pad to hold the pointer
in place while you click the right or left button. The left button is used to select
The PC Help Desk
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something in Windows 98 by clicking and releasing the button. To activate or
open something, you will want to click the left mouse button twice in rapid
succession. You may need to practice this some to get comfortable with it.
The right mouse button gives you a context sensitive menu of functions you
can perform when you click it. By this, I mean that the menu you'll see when
you click the right mouse button will depend on where you are. I encourage
you to get to know your mouse as it will be your best friend when you're using
your computer.
An operating system (OS) is the software that allows a computer user to
interact with a computer. For instance: some computers use MS-DOS
(Microsoft's Disk Operating System) that chiefly uses the keyboard. Some
computers run UNIX. Earlier versions of Windows were not actually an
operating system, but ran as an application under some version of DOS.
Windows 95/98 and Windows NT are the first operating system versions of
Windows. Windows (95/98 and NT), DOS, and UNIX are all operating
systems.
If you have any comments about what you read in this manual, please take the
time to send them to me. You'll find my mailing address on the inside of the
cover sheet along with my E-Mail address for those of you who have Internet
access.

The PC Help Desk
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Look and Feel of Windows 98
Starting and Stopping Windows 98
While it's easy to turn your computer on and off, there are a few things you
need to keep in mind when you do.
Turn the Screen on First
When you turn on your computer, be sure to turn on your monitor first. The
reason for this is that your computer will do some diagnostic tests and load
some programs as it comes up. If a problem is detected, the information
displayed on the screen might be helpful in figuring out what is wrong with
your computer.
<F8> Boot Options
If you want to modify the system startup procedure, press <F8> when you see
the message that says Starting Windows 95 and you will get a menu of
different options. For example, if you wanted to bring the system up in DOS
rather than in Windows, option 5 from the menu would allow you to do this.
Windows 98 doesn't give you a message like Windows 95 does. <F8> works
with Windows 98 the same as it does with Windows 95, but it's not easy to
know exactly when to press <F8>. As a result, I would recommend that you
just try <F8> periodically as your system is booting up.
System should come up ready to use
Under normal operation, your system should come up into Windows and be
ready to use. If it doesn't for any reason, seek help unless you know what the
problem is and how to correct it.
Shut the System Down Properly
Finally, when you're ready to turn your computer off, be sure to shut it down
properly. Windows maintains a lot of information in memory in order to do the
things it does for you. If you just turn power off without shutting it down
properly, you stand a good chance of losing some information or doing damage
to your system. To properly shut your system down, click on the Start
button and then click on Shut Down.... The underlined letter in the
preceding is the key you can use instead of the mouse to select this. You'll get
The PC Help Desk

3

7/7/04

I N T R O D U C T I O N

T O

W I N D O W S

9 8

a window asking for confirmation before your system shuts down. The
window should look something like this:

If, for some reason, you need to restart your system, you will follow this same
procedure for shutting the system down except that you will change the option
on the window that pops up.
Now, I can already hear you complaining about this procedure for shutting your
computer down so I thought I would share this little tidbit with you I received.
I apologize for not knowing the original author.
Costello: "Hey, Abbot!"
Abbot: "Yes, Lou?"
Costello: "I just got my first computer."
Abbot: "That's great Lou. What did you get?"
Costello: "A Pentium II-266, with 40 Megs of RAM, a 2.1 Gig hard drive, and a
24X CD-ROM."
Abbot: "That's terrific, Lou."
Costello: "But I don't know what any of it means!"
Abbot: "You will in time."
Costello: "That's exactly why I am here to see you."
Abbot: "Oh?"
Costello: "I heard that you are a real computer expert."
The PC Help Desk
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Abbot: "Well, I don't know-"
Costello: "Yes-sir-ee. You know your stuff. And you're going to train me."
Abbot: "Really?"
Costello: "Uh huh. And I am here for my first lesson."
Abbot: "O.K. Lou. What do want to know?"
Costello: "I am having no problem turning it on, but I heard that you should be
very careful how you turn it off."
Abbot: "That's true."
Costello: "So, here I am working on my new computer and I want to turn it off.
What do I do?"
Abbot: "Well, first you press the Start button, and then-"
Costello: "No, I told you, I want to turn it off."
Abbot: "I know, you press the Start button-"
Costello: "Wait a second. I want to turn it Off. I know how to start it. So tell
me what to do."
Abbot: "I did."
Costello: "When?"
Abbot: "When I told you to press the Start button."
Costello: "Why should I press the Start button?"
Abbot: "To shut off the computer."
Costello: "I press Start to stop."
Abbot: "Well Start doesn't actually stop the computer."
Costello: "I knew it! So what do I press?"
Abbot: "Start."
Costello: "Start what?"
The PC Help Desk
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Abbot: "Start button."
Costello: "Start button to do what?"
Abbot: "Shut down."
Costello: "You don't have to get rude!"
Abbot: "No, no, no! That's not what I meant."
Costello: "Then say what you mean."
Abbot: "To shut down the computer, press-"
Costello: "Don't say, 'Start!'"
Abbot: "Then what do you want me to say?"
Costello: "Look, if I want to turn off the computer, I am willing to press the
Stop button, the End button and Cease and Desist button, but no one in their
right mind presses the Start button.
Abbot: "But that's what you do."
Costello: "And you probably Go at Stop signs, and Stop at green lights."
Abbot: "Don't be ridiculous."
Costello: "I'm being ridiculous? Well. I think it's about time we started this
conversation."
Abbot: "What are you talking about?"
Costello: "I am starting this conversation right now. Good-bye."

Parts of the Screen
The Windows 98 screen consists of the Desktop, the Taskbar and windows.
The Desktop contains some number of icons providing access to different
functions. The Taskbar contains the Start button giving access to nearly
everything on the system. Each program running on the system will be in a
window. Windows consist of several parts: title bar, menu bar, scroll bars, etc.
The Windows 98 screen might look something like the following:
The PC Help Desk
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Your desktop icons are usually down the left side of the screen as you see here.
To activate any of these functions, simply double-click on them.
The Taskbar is normally across the bottom of your screen as you see above.
At the left end of the Taskbar is the Start button that gives you access to all
the programs available on your computer. To the right of the Start button,
you'll see a button for each window you have on the desktop. On the right end
of the Taskbar is the SysTray that will normally contain some number of
icons in addition to the system time. If you pause the mouse on any icon on the
Taskbar, the system will tell you something about it. For example, if you
pause the mouse over the time, the system will tell you the day of the week and
the date as well. If the Taskbar gets in your way, it can be moved or hidden as
explained in Taskbar on page 94.
Windows 98 adds something neat to the Taskbar - Toolbars. If you right-click
on the Taskbar (not on an icon), you'll see a context sensitive menu. The first
item on this menu allows you control of the Toolbars you can have on your
Taskbar. These Toolbars give you quick access to any function you want
included simply by single clicking on them.
The PC Help Desk

7

7/7/04

I N T R O D U C T I O N

T O

W I N D O W S

9 8

Windows will take up some amount of your screen - perhaps even the entire
screen depending on how the program has been instructed to run. For now, we
will assume that programs run in a window as displayed above. The top line of
a window is referred to as the Title Bar. On the left end of the Title Bar is the
Control button familiar to people who have used an earlier version of
Windows. Next is the name of the program running in the window along with
possibly the file on which the program is working. On the right end of the Title
Bar are three buttons. The right-most button has an "X" on it and will close the
window if you click on it. The next button looks like a miniature window and
will toggle the window between window and full screen. The third button
looks like an underline and will minimize the window dropping it down to an
icon on the Taskbar. The program is not closed, but is simply not taking up any
space on the desktop any longer. After clicking on this button, you can get the
window back by clicking on the appropriate button on the Taskbar.
Under the Title Bar is the Menu Bar that will normally contain some number of
items. Clicking on each of these will result in a menu of functions from which
you can select. The content of the Menu Bar will depend on the program
running in the window.
In the window above, there are two scroll bars - one for the left part and one for
the right part of the window. A scroll bar may be down the right edge of a
window or across the bottom of a window or both. The purpose of a scroll bar
is to allow you to view information that won't fit in the window - you can scroll
up or down to see the rest of the information. There are several ways in which
you can use the scroll bar. First, there's an arrow on either end of the scroll bar
that will move the information in that window one line at a time each time you
click on it. Second, you can click on either side of the slide bar to scroll a
screen at a time. Third, you can click on the slide bar itself and drag it up or
down to see whatever part of the information you want to get to. All three
methods of scrolling are useful depending on the situation.
The content of the remainder of the window will depend on the program
running in the window.

Moving Windows
The title bar of every window is like the handle of a suitcase. By putting the
mouse on it and holding down the left mouse button, you can drag the window
around on your Desktop. When you release the left mouse button, the window
will be in the new position. Moving a window can give you access to
information in a window hidden behind.
The PC Help Desk
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Resizing Windows
You already know how to use the Maximize button to switch between a
window and full-screen. Windows can be adjusted in a more granular fashion
as well. When you move your mouse to a horizontal border, your mouse
pointer will change to a . When you move your mouse to a vertical border, it
will change to a . You'll see a diagonal arrow when your mouse is on one of
the four corners of a window. Click and hold your left mouse button when you
see this change in your pointer and drag to resize your window.
You have three ways of resizing windows using the borders:
•

Horizontal Border - resizes a window up or down

•

Vertical Border - resizes a window left or right

•

Corner Border - resizes a window up or down and left or right

Arranging Windows
You already know how to move windows around on your screen and how to
resize windows so you can see what you need. There are three predefined
desktop layouts you can use as well. These predefined desktop layouts are
accessible by right-clicking on the Taskbar (not on an icon) and selecting the
appropriate layout. What you will see should look something like this:

The underlined letter on each item on this menu can be used if you don't feel all
that comfortable using the mouse to select items.
Cascade Windows
Windows will be arranged in a stair-step fashion where you can see the title bar
of all non-active windows behind your active window.
The PC Help Desk
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Tile Windows Horizontally
Each window will go from the left edge to the right edge of the screen and take
up an equal amount of the vertical space of the screen.
Tile Windows Vertically
Each window will go from the top to the bottom of the screen and take up an
equal amount of horizontal space of the screen.
While you're looking at this menu, you might explore the other items available
to you here, but I won't spend time on them now. Just be aware that you do
have other options here. Be careful about making changes until you know the
full meaning of those changes though.

Arranging Icons
Your Desktop comes with some icons and over time, you may add additional
icons to give you quick access to things on your computer. These icons can be
moved around on your screen to be more convenient for you. Simply click and
hold the left mouse button on an icon and drag it wherever you want it. You
can also use some predefined functions to arrange the icons on your Desktop.
When you right-click on your Desktop (not on an icon or window), you'll get a
menu containing a couple of functions that can be used to control the
arrangement of the icons on your Desktop. The menu should look something
like this:

Arrange Icons
By pausing your mouse on this item, you'll see another menu that allows you to
arrange the icons on your Desktop according to Name, Type, Size or Date
in addition to allowing Windows to arrange the icons for you.
The PC Help Desk
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Line Up Icons
This simply moves your icons into a nice neat row.
Experiment with the different arrangement of the icons on your Desktop to get
the look you want.

Wallpaper Your Desktop
Windows comes with several files that can be used as the background for your
Desktop. These include Black Thatch, Blue Rivets, Bubbles, Carved Stone,
Circles, Chess, Clouds, Forest, Gold Weave, Houndstooth, Metal Links,
Pinstripe, Red Blocks, Sandstone, etc. These files are bitmap or BMP files and
are found in your Windows folder. You can create your own bitmap files with
Paint (see page 66) and use these as wallpaper for your Desktop as well.
To change your wallpaper, right-click on the Desktop and select Properties.
Select your wallpaper and Tile or Center it to suit your tastes. Click on Apply
or OK to implement your wallpaper. Experiment with the different wallpaper
to customize your Desktop to your liking. The Display Properties dialog box
should look something like this:

The PC Help Desk
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We'll talk about using Paint to create bitmap files later in the material. There
are also bitmap files that you can pick up on the Internet that can be used as
wallpaper. For example, the file you see in the Display Properties dialog box
above makes a striking wallpaper.
You can also pick up a copy of Microsoft Plus! that allows you to customize
more than just your wallpaper. The Plus! pack contains Desktop themes which
include wallpaper, icons, screensavers and sounds pertaining to different
themes. And add-ons to the Plus! pack give you a wide variety. Plus! is part
of Windows 98.

Setting Your Screensaver
In the early days of personal computers, screen savers were a necessity. The
monitors used back then were monochrome monitors and if an image were left
on the screen for any length of time, the image would burn itself into the screen
and be there permanently. To prevent this from happening, screen savers were
invented. Screen savers had one function - make constant changes to what was
The PC Help Desk
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displayed on the screen to prevent burn-in. As time went on, screen savers
became more elaborate. Some of the designs used were actually fun to watch.
With the advent of VGA color monitors, it became impossible to burn an image
into the screen so the need for screen savers disappeared. They are nice to look
at however and a lot of people enjoy them. Be aware that they can affect
applications running on your system. This may not be important to you, but
you need to be aware of it anyway.
To set up a screen saver, right-click on your Desktop and select Properties.
One of the tabs across the top of the window you get will be Screen Saver.
Click on this tab and select the screen saver you want. Once you have it
configured, click on Apply or OK to implement your screen saver.
Windows comes with a number of different screen savers including Blank
Screen, Flying Windows, Flying Through Space, Mystify Your Mind and
Scrolling Marquee among others.
If you pick up a copy of Microsoft Plus!, you'll get a different screen saver to
go with each of the themes you get. Some of these are pretty impressive. The
Plus! pack comes with Windows 98.
There are several packages of screen savers that you can pick up if you want
something unique.

The PC Help Desk
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Switching Between Windows
Windows 98 provides the ability to run more than one application or program
at a time. Unfortunately, the size limitation of most screens makes it difficult
to see everything about all applications you can have running. The Taskbar at
the bottom of your screen allows you to switch between running applications
simply by clicking on the button associated with a particular program. In
addition to using the Taskbar to change between active applications, you can
use the <Alt><Tab> key combination to quickly switch tasks.
You can switch windows simply by clicking on the appropriate icon on the
Taskbar. And since the Taskbar is always available to you, why have
another method of accomplishing the same thing? Well, this is true, but it
requires you to move your hand from the keyboard, grab the mouse, move it to
the Taskbar and click on a different application. All of this takes time. With
<Alt><Tab>, you keep your fingers on the keyboard, but can quickly switch
between applications. Here's how it works.
The PC Help Desk
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Press and hold down the <Alt> key. Tap the <Tab> key and a window will
pop up in the middle of your screen showing you all the applications you
currently have running on your machine. One application will be highlighted
with a box around it. If this is the application you want to switch to, then
release the <Alt> key and that application will come to the foreground. If the
highlighted application isn't the one you want, simply continue to tap the
<Tab> key until the application you want is selected and then release the
<Alt> key. It's just that easy. And you never move your hands from the
keyboard.
Windows 98 provides another neat feature. With Windows 98, you can
actually have more than one monitor attached to your system. You can have
one monitor with one application on it and another application running on the
second monitor. You still need to be able to switch between these applications.

Using Dialog Boxes
Applications use dialog boxes to obtain information when necessary. Dialog
boxes take on a variety of forms, but generally contain certain user selectable
options.
Click the up or down arrows to change the value.

Click the option(s) you want. You can select
more than one.
Click the down arrow to see a list of options; then
click the option your want.

Type your selection in the box.

Click the option you want. You can only select
one.
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Drag the slide on the bar to make your selection.

Click the up or down arrows to move through the
list, and then click your selection

The PC Help Desk
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Starting Programs
With Windows 95/98, it's easy to run any of the applications that are installed
on your machine. With a few exceptions, all applications are started using the
Start button:
1. Click the left mouse button on the Start button on the Taskbar.
2. Move your mouse up to point to Programs - no need to click. The
available programs and groups will appear to the right.
3. Move your mouse to the right to point to Accessories. Again available
programs and groups will appear to the right.
4. Click the left mouse button on WordPad.
5. Type in some information.
6. To close WordPad, click on the Close button (the one with the "X" on
it) in the upper right corner of the WordPad window. You'll get a
dialog box asking you what you want to name the file and where you
want to save it. We'll talk about naming files and where to put them in
Naming a File on page 26.
7. Name your file My File.

As an exercise, try opening and closing the program called Paint. You'll find it
in the Accessories group where you found WordPad. Both Paint and
WordPad come free with Windows 98. WordPad is a word processing
The PC Help Desk
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program that isn't as powerful as Microsoft Word or WordPerfect, but
considerably more powerful than Notepad. Paint is a drawing program that
can be used to create graphics.

The PC Help Desk

18

7/7/04

I N T R O D U C T I O N

T O

W I N D O W S

9 8

Exploring You Hard Drive
Let's examine a couple of ways in which you can explore the contents of your
hard disk. The first is through My Computer and the second is by using an
application known as the Windows Explorer. Each of these has advantages
and disadvantages. My computer is easily accessible and provides a simplistic
view of whatever you're after, however, it gives you a separate window for
each object. The Explorer gives you a single window containing everything
on your system, but may lead to information overload.

My Computer
You can look at just about anything on your computer through the My
Computer icon on your Desktop.
1. Double-click on the My Computer icon on the Desktop. The window
shows you an icon for everything on your computer.

2. Double-click on C-drive icon. This opens another window showing you
the content of your C-drive.
The PC Help Desk

19

7/7/04

I N T R O D U C T I O N

T O

W I N D O W S

9 8

3. Scroll down to the Windows folder and double-click on it. This opens
another window showing you the content of the Windows folder.
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4. Scroll down to the file called Clouds and double-click on it. This is a
graphic file that comes with Windows 98. By double-clicking on it,
Windows brings up Paint and loads this file.
The file that you created earlier called My File may be in the same folder as
Clouds. See if you can locate it and double-click on it. Don't be surprised if
My File is not in the same folder as Clouds. It may be elsewhere on your
system and we'll locate it later. You created this file using WordPad, but when
you double-click on it, Windows 98 will bring up Word instead if this
application is available on your system. The reason is that Word is a more
powerful word processor than WordPad. If Word is not installed on your
system, Windows 98 will bring up WordPad.
Windows knows about file types and will automatically associate files that
have a particular extension with the appropriate application. The extension on
the Clouds file is BMP that is associated with the Paint application. The
extension on the My File file is DOC that is associated with the Word
application if Word is present; otherwise it is associated with the WordPad
application. For more information, see File Association on page 28.
CAUTION: Don't attempt to use the file name extension for your own
purposes or Windows will not be able to associate the file properly.

Windows Explorer
Using My Computer to look at what's on your computer is okay, but the
number of windows you get could be overwhelming before too long.
Fortunately, Windows 95/98 comes with another tool that simplifies things. It's
called the Windows Explorer or Explorer for short. To bring up the
Explorer, click on the Start button and point to Programs. The
Explorer should be close to the last item in the list that comes up. If your
keyboard has the Windows key (one will be between the <Ctrl> and <Alt>
keys to the left of the space key), try pressing <Windows>E to bring up the
Explorer.
Bring up the Explorer and go find the Clouds file you looked at earlier.
HINT: Look in the Windows folder on the C-drive.
The Windows Explorer is a very powerful tool for exploring your system.
There are a couple of things that can enhance its power even more though.
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The default for the Explorer doesn't look much different from My Computer.
You do see everything on your system on the left side and the contents of
whatever you want on the right side, but it still shows just icons. You might
like to have some additional information. If you click on View and select
Details, you'll see more information about the files and folders you're looking
at.
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You can change the sort order of the right window of the Windows Explorer
simply by clicking on the title button at the top of the right panel to toggle the
sort order from ascending to descending or back. In addition, this view allows
you to see the date/time the files/folders were last modified. This information
will come in handy as you work with your system.
You can adjust the size allocated to a particular field by double-clicking on the
line between that field name and the next field name. For example, if you
double-click on the vertical line between Name and Size, the Name field will
expand to show you the full name of any file/folders in that pane.
You have access to a number of functions via the menu bar at the top of the
Explorer, but it might be nice to have quicker access to those functions you'll
use most frequently. In the View menu, you can click on Toolbar to activate a
toolbar with frequently used functions. If you pause on each of the items on the
toolbar, the system will tell you what they do. While you're at it, you might
also select Status bar from the View menu giving you a lot of useful

information as you explore your system.
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Working With Files
If you are familiar with working with files in DOS or earlier versions of
Windows, you have some surprises coming in Windows 98. Although the old
concept of 8.3 file naming convention still works in Windows 98, this
restriction has been lifted giving you the freedom to name files pretty much
anything you want.
In Windows 98, you have to go out of your way to see the 3-character
extension given to files. For the most part, this extension is now hidden
although it is still present.
The 8-character file name has now been expanded to 250 characters including
some special characters that use to be restricted. For example, you can now use
blanks in the file name that allows you to give your files very meaningful
names.
Let's take a look at several aspects of working with files.

Finding a File
If I tell you there's a file on your system called General.TXT and that this file
is in the Windows folder and that you should use Notepad to look at it, you
would probably have no trouble bringing it up and looking at it. On the other
hand, if I were to tell you that there's a bitmap file on your system called
Clouds and ask you to go look at it, you might have a bit more trouble. Where
do you look for the file? How do you locate it? Enter the Windows 98 Find
function:
1. Click on the Start button.
2. Point to Find.
3. Click on Files or Folders....
4. Enter whatever you remember about the file name and click on Find
Now. Your file should appear at the bottom of the Find window.
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For example, I told you there's a bitmap file on your system by the name of
Clouds. That's all you know about the name so you enter that in the Named:
field and click on Find Now. The resulting Find window should look
something like this:

By double-clicking on the Bitmap Image file, you'll bring it up in Paint.
Notice that there are other tabs across the top of the Find window where you
can enter other information about the file(s) you might want to look for. The
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Date tab allows you to look for files based on when they were created or last
modified. The Advanced tab allows you to look for particular file types and/or
specific size files.

Naming a File
File names are no longer restricted to 8.3 as they use to be with earlier versions
of Windows. You can now name a file with up to 250 characters. Most
applications allow you to create a file and then name it as you save it.
Although you can specify a file extension, you are better off if you let the
application supply the extension and you supply the name. With 250 characters
including spaces to play with in Windows 98, you can be pretty descriptive
with your file name.
DOS and older versions of Windows used an 8.3 file naming convention
meaning that you had 8 characters you could use in naming a file. A lot of
people used the 3-character extension to allow them to name files a little better.
This causes problems with file association that is a feature of Windows.
Windows 98 extends the 8 characters you are free to use to 250 characters and
allows you to use some special characters such as spaces in the name. It should
no longer be necessary to use the 3-character extension. There are still some
restrictions on what you can put into a file name. You should stay away from
the following characters as they will cause problems for the system: \ / : * ? " <
>|
As a matter of fact, Windows 98 tries to hide the 3-character extension from
view. Unless you really try, you won't see the extension. You can force
Windows 98 to show the extension if you really need to see it, but you're better
off without it.
While we're on the subject of files, let's talk a little about where you want to put
the files you create. You will put files somewhere unless you decide not to
create anything on your computer. Every application has a default location
where files are store unless you change it. Most of the time, this default
location is where the program you're running is stored. In other words, you
have data and programs stored in the same place. This may seem convenient,
but there are a couple of reasons not to do this. First, putting your data with
your programs can make it difficult to locate your data when you want it.
Second, sooner or later, you will want to back up your data. If your data is
intermixed with the programs, it will be difficult to just back up the data and
not the programs. If all your data is organized in one place, you always know
where it is and it's easy to back up since you don't have to go looking for it.
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What I suggest is that you create a folder on your hard drive and put all your
data files in that folder. It doesn't matter what you call this folder as long as you
reserve it for your data files and don't store any programs in it. Some systems
will have a folder called My Documents that can be used for this purpose. If
this folder doesn't exist, you might create it or perhaps create one named Data.
Now you have a place to put all those files you create.
It won't take too long before you start having difficulty locating files within this
folder because of the number of files you are accumulating. You have to look
through all the files to find the specific one you're looking for. Perhaps it
would be a good idea to organize your files some. Perhaps some of your files
relate to business while others are of a personal nature. How about creating a
couple of lower level folders called Business and Personal. You could have
more than just these two, and yours could have other names. Now you can
quickly zero in on your business files or your personal files without having to
worry about the other.
Your personal files might still get rather crowded though over a period of time.
Let's assume you write one letter a week. By the end of the year, you would
have some 52 letters stored in your Personal folder. This may not be too bad,
but after two years, it might be a little difficult to locate a particular file.
Suppose we create a folder in Personal for each year. We might have folders
called 1997, 1998, etc. This might help, but if you create more files than just
52, this might still not be enough. You might want to have a further breakdown
of your files. Perhaps you would want a folder for those letters you write to
Uncle Harry and another one for Aunt Mary.
Obviously the names you pick are purely up to you and you will probably want
more of a breakdown than this, but your Data structure might look something
like this:
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Copying a File
With Windows 98, it's easy to copy and move files from one place to another.
Using either My Computer or Windows Explorer, simply right-click on the
file you want to copy and select Copy from the context sensitive menu. Then
right-click where you want to place a copy of the file and click on Paste. A
copy of the file will be placed there.
Another way to copy a file is to use the Edit menu at the top of the My
Computer or Windows Explorer screen to select Copy. You can also use the
hotkeys for Copy (<Ctrl>C) and Paste (<Ctrl>V).

Moving a File
The procedure for moving a file is similar to that for copying a file. Right-click
on the file you want to move and click on Cut in the context sensitive menu.
Then simply Paste the file where you want it to go. Again you can accomplish
this by going to the Edit menu and selecting Cut there or by using the hotkeys
for Cut (<Ctrl>X) and Paste (<Ctrl>V).

File Association
Windows is familiar with the default file extensions used by most application.
By allowing applications to use their default extensions, you can bring up a
particular application and load a file into it simply by double-clicking on the
data file. This doesn't work if you override the default extension for the
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application. As a result, Windows 98 doesn't normally show you the extension
on files. You have to specifically request to see it. If you're looking at a
Details view of files, however, Windows will tell you what Type of file you
are looking at. For most purposes, this should be sufficient.
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Games
People generally don't think of games as a learning tool, but in the case of the
games that come with Windows, they may be fun, but you learn as well. If you
feel a little rusty when it comes to using the mouse to navigate around in
Windows, perhaps the games are just the ticket for you. They are fun to play,
but they will give you experience using the mouse and make you more
comfortable with the system in general.
To start a game:
1. Click the Start button.
2. Point to Programs, point to Accessories, and then point to Games.
3. Click on a game.
If you do not see any games on your Accessories menu, then you did not install
any games when you installed Windows.
Four games come standard with Windows 98 and will be described.

FreeCell
FreeCell is a very enjoyable game. As solitaire games go, it is much more
enjoyable than most of them as you can win more often than not. When I first
started playing FreeCell, I was able to win about 50% of the time. That
quickly rose as my experience in the game increased. Here is a sample screen
from FreeCell along with a brief description of the screen and what goes
where. Although you can read the Help for the game yourself, I’ve included a
few things here to get you started.
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The four cells in the upper left of the screen are the free cells that can contain
one card at a time each. You must remove cards before you can put another
card in each of these cells. The four cells in the upper right of the screen are
the home cells and will start with the aces and build up to kings. The bottom
section of the screen contains eight stacks of cards laid out face up in a random
order. You can move cards around using alternating colors by clicking on the
card(s) you want to move and then on where you want them to go. By default,
cards that can go to the home cells will do so as soon as they are uncovered.
The object of the game is to move all the cards to the home cells, using the free
cells as placeholders. To win, you make four stacks of cards on the home cells:
one for each suit, stacked in order of rank.
It is believed (although not proven) that every game is winnable.
To play FreeCell: starting the game
1. On the Game menu, click New Game.
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The FreeCell game area consists of the four home cells (Home cells are
the four card locations in the top right corner of the screen. Aces can be
moved to the home cells immediately, and other cards of the same suit
can be moved on top of them in ascending order. You win the game by
moving all the cards to the home cells.), four free cells (Free cells are
the four card locations in the top left corner of the screen. Each cell can
hold one card.), and the deck of cards, which is dealt face-up in eight
columns at the beginning of the game.
2. To move a card, click the card you want to move, and then click the
area you want to move the card to. There are three places you can move
cards to in FreeCell:
•

Move to a free cell: any card from the bottom of a column.

•

Move to a home cell: any card from a free cell or from the
bottom of a column. Moves to a home cell must be made in
order of lowest to highest, same suit. Aces can always be
moved to an empty home cell.

•

Move to the bottom of a column: any card from a free cell or
from the bottom of another column. Moves to a column must be
made in order of highest to lowest, alternating suit colors.

To play FreeCell: strategy and tips
•

Before you make your first move, look for trouble spots like aces
hidden at the tops of columns, or both red sevens stacked behind three
kings.

•

Try to keep your free cells unoccupied as much as possible. Empty
columns are also valuable.

•

To cancel a move, click the Game menu, and then click Undo, or click
the card you just moved again.

•

To reveal a partially hidden card, use the right mouse button to click it.

•

If you have already put two or more cards in sequence in a column, you
can move the entire sequence to a different column if there are enough
free cells open. To move several cards at one time, click the bottom
card of the sequence you want to move, and then click the column you
want to move it to.
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•

To move a card quickly to a free cell, double-click the card.

•

At the end of each move, FreeCell transfers unneeded cards to the
home cells. A card is unneeded if there are no lower rank cards of the
opposite color left in the playing area.

•

When only one legal move remains, FreeCell warns you by flashing the
title bar.

Hearts
This is the typical game of Hearts where you are playing against three other
players in an attempt to have the lowest score when one of the players reaches a
score of 100. In this version of the game, the other three players are the
computer.
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The object of Hearts is to have the lowest score at the end of the game.
Hearts is a four-player game. If you are connected to a network, you can have
other players on other computers on the network. If you're not connected to a
network, you can let your computer play the other three hands.
To play Hearts: starting the game
1. To connect to a game that is already being played over a network, click
"I want to connect to another game."
2. To start a new game over a network, click "I want to be dealer," and
then wait for other players to join the game.
3. To play by yourself against your computer, click "I want to be dealer,"
and then press <F2>.
4. Select three cards to pass to an opponent (except for every fourth hand,
when no cards are passed). To select a card to pass, click it. To
deselect a card, click it again.
5. The player who has the two of clubs starts the play by leading it.
6. Each player, moving clockwise, clicks a card to play. You must play a
card in the same suit. If you do not have one, you can play any card,
except that you cannot play a heart or the queen of spades on the first
trick.
The person who plays the highest card of the same suit as the first card
played takes the trick. That player starts the next trick by clicking a
card to lead. You cannot lead a heart until a heart has been played on a
previous trick.
Scoring
•

At the end of each hand, you get one point for each heart in your hand
and 13 points for the queen of spades. The game continues until one
player gets 100 points or more, or until the dealer quits the game.

•

If you win all the hearts and the queen of spades in one hand (called
Shooting the Moon), then you get zero points and each other player is
penalized 26 points.

The PC Help Desk

34

7/7/04

I N T R O D U C T I O N

T O

W I N D O W S

9 8

To play Hearts: strategy and tips
•

In most cases, avoid taking a trick (The cards you collect when you play
the highest card that is the same suit as the first card played in a round.)
containing hearts or the queen of spades. The only time you will want
to take such tricks is when you are trying to Shoot the Moon (Winning
all the hearts and the queen of spades in one hand. When that happens,
you get zero points and each other player is penalized 26 points. Your
chances of Shooting the Moon are best if your hand contains a large
number of high-value hearts and spades.) or trying to prevent someone
else from successfully Shooting the Moon.

•

On hands that begin by passing cards to an opponent, pass cards with
high values, such as aces or face cards.

•

It is best to play your highest cards early in the game, while your
opponents are likely to have some cards in each suit and will have to
play those cards instead of hearts. Tricks that do not contain any hearts
or the queen of spades do not add to your score.

•

You need to keep track of which cards have been played, particularly
whether the queen of spades has been played and whether hearts have
been broken (that is, whether a heart has been discarded on an earlier
trick).

Minesweeper
Minesweeper is a very fascinating game involving strategy and skill as well as
a certain amount of luck. I have enjoyed this game since back in the Windows
3.1 days. There are a couple of different versions of this game, but they all
work basically the same and it will give you plenty of experience using the
mouse.
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The object of the game is to find all the mines on the playing field as quickly as
possible without uncovering any of them.
To play Minesweeper: starting the game
1. On the Game menu, click New.
The Minesweeper game area consists of the mine counter, the timer,
and the playing field.
2. Click any square on the playing field to start the timer.
•

To uncover a square, use the left mouse button to click it. If it is a
mine, you lose. If a number appears on the square, it specifies how
many mines are in the eight squares that surround the numbered
square.

•

To mark a square you suspect contains a mine, use the right mouse
button to click it.

To play Minesweeper: strategy and tips
•

To mark a square you are uncertain about, use your right mouse button
to double-click it. This marks the square with a question mark (?).
Later, you can either mark the square as a mine, or uncover it.

•

If you have found all the mines around a numbered square, uncover the
remaining squares around it by clicking the numbered square with the
left and right mouse buttons simultaneously.
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Look for common patterns in the numbers. Often, but not always, a
pattern of numbers indicates a specific pattern of mines. For example,
the pattern 232 at the edge of a group of uncovered squares indicates a
row of three mines next to the three numbers.

Solitaire
This is the standard Solitaire game. The game is neat and provides a lot of
experience using the mouse in a Windows environment. My only complaint is
that you have to play a lot before you can win. I guess I get discouraged
because I can't win more often.

The object of the game is to use all the cards in the deck to build up the four
suit stacks from ace to king.
To play Solitaire: starting the game
1. On the Game menu, click Deal.
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2. Begin play by double-clicking any aces on top of the seven row stacks
to move them to the spaces at the top right of the screen and then
making any other plays available on the board.
You will be building two kinds of stacks: row stacks (Cards are stacked
in descending order, alternating between red cards and black cards. For
example, you can play the two of hearts on the three of clubs.) and suit
stacks (Cards are stacked in the four areas at the top right of the screen
in ascending order, beginning with aces. For example, you can play the
two of hearts on the ace of hearts.).
To free up cards that you need to build the suit stacks, you build row
stacks.
To move a card or a stack of cards from one row stack to another, drag
it.
To move a card to a suit stack, double-click it.
3. When you have made all the available plays on the board, click the deck
to begin turning over cards. The card that is face up on top of the deck
is always available for play.
To choose a scoring system
1. On the Game menu, click Options.
2. In the Scoring box, click Standard scoring, Vegas scoring, or None.
Note
On the Options menu, you can also specify whether to draw one or three cards
at a time. These options are scored slightly differently.
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Applications
Windows 95/98 comes with a number of applications that can make you
productive immediately without having to install expensive software on your
system. Clicking on the Start button, pointing to Programs, pointing to
Accessories, and then clicking on the application name can start most of these
applications. You should find the following applications if they have been
installed on your system and we'll take a look at each of these.

Notepad



There will be times when you will want to edit textual files. Textual files are
different from documents created by WordPad, Word or WordPerfect or some
other word processing program in that they contain no imbedded codes.
Editing these files with a word processing program can introduce special
characters that make these files unusable. Instead, use Notepad which allows
you to edit the file as pure text.
Textual files will normally have a TXT file extension, but there are several
special purpose files in Windows that must be pure text. Some of the more
important of these include your CONFIG.SYS, AUTOEXEC.BAT, WIN.INI
and SYSTEM.INI. You may get to the point of wanting to play with these
files. If so, use Notepad to edit these and not WordPad as your system cannot
use the resulting WordPad file. If you decide you want to create a web page,
but don't have an HTML editor, you will want to use Notepad so as not to
introduce those nasty characters associated with WordPad, etc.
In addition to having a tool to use in editing those special files on your system,
learning Notepad can provide a good foundation for learning some of the other
tools that come with Windows 98 as well as a number of the applications that
you may want to add to your system later. Notepad is simple to learn but has
some features in common with other programs.
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The first thing I want to point out in the above is that I have entered some text
into Notepad. Notice that the text just runs off the end of the window - it
doesn't wrap. We'll correct that in a minute, but this is the default for Notepad.
You could, of course scroll to the right in order to see the rest of the
information I entered or enlarge the window. Okay, let's look at some of the
features of Notepad. Let's start off by looking at each of the menus across the
top of Notepad. Before we go to the individual menus, notice something about
the menu bar itself. See the underlined letters in each of the menu items (File,
Edit, Search, etc.)? These are meaningful. If you hold down the <Alt> key
and press these letters, you will select that menu. Obviously you can select
each menu with the mouse, but this gives you an alternative way of getting into
them. So, you can get into the File menu by pressing <Alt>F.
File Menu
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This is the File menu. Notice a couple of things about this menu. First, notice
that there are underlined letters on each selection. Again, although you can
select each item with your mouse, you can do it with the keyboard as well. In
this case, since you are already in the menu, you don't need the <Alt> key;
simply press the underlined letter to select a particular item. Second, notice the
"..." at the end of several selections. This indicates that selecting these items
will take you to a dialog box that will allow you to carry out that operation.
N e w - This will start a new document. If you are currently working on a
document that you haven't saved, the system will prompt you to save the old
document before starting a new one.
O p e n . . . - This allows you to bring an existing document into Notepad to
view and/or edit it. You'll see the following dialog box when you make this
selection:

This is the standard Open dialog box used by most Windows 98 programs. It
consists of a toolbar across the top that shows you which folder you are
currently in along with a couple of control buttons for getting to where you
want to go. The main part of the Open dialog box shows you the files/folders
that match the criteria for this application. In this case, all we see are folders.
Next is where the system will tell you the name of the file it thinks you want.
Right now, it doesn't know so it assumes you want to look at all TXT files.
Next is where you can tell the system what type of files you are interested in
looking at. By default, Notepad looks at Text Documents, but you can change
this to look at anything else. Finally, you can either Open the selection or
Cancel this operation.
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S a v e - If you are making modifications to an existing file, Save will put the
changes back into the file after confirming that you really want to make the
changes. If the file you are working on is a new file, Save works the same as
Save As....
S a v e A s . . . - Save As... brings up a dialog box similar to the Open dialog
box above. By default, Notepad will save a new file in the Windows folder.
It's easy enough to change folders and save a file anywhere on the system you
want though. I would encourage you to create a special place where you save
your files rather than putting them in the Windows folder. See Naming a File
on page 26 for some suggestions on how to organize your data.
P a g e S e t u p . . . - The Page Setup... dialog box allows you to customize
some of the things you see when you print your document. For example, you
can change the size of your paper, customize the header and footer on each
page as well as the margin at the top, bottom and either edge of the paper. The
Page Setup... dialog box looks like this:

P r i n t - This is a standard print operation sending the information to the
default printer. The only way to change the printer is to change your default
printer.
E x i t - This shuts down Notepad. If the file you've been working on has not
been saved, you will be prompted to save the file before Notepad exits.
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Edit Menu

The Edit menu contains those functions that allow you to manipulate the
information you have on the screen. As was the case with the File menu, you
have an underlined letter on each item and some hot keys down the right side.
These work the same as they did before. In this case, there are some items that
appear dim in the menu. The reason for this is that these items are not available
at the present time. In most cases, you have to have something selected for
these items to work. Windows does a pretty good job of communicating with
you to tell you what you can and cannot do. Also notice that most of the items
in the Edit menu have a key combination on the right (Ctrl+Z, etc.). These are
hot keys that can be used from within the document without having to go to the
Edit menu. For example, you can do a Copy from within a document by
holding down the <Ctrl> key and pressing the "C" key. I don't recommend
that you try and memorize these hot keys just now. Instead, I would
recommend that you just make note of them as you use the menu items and
over time pick up on those you use most frequently.
U n d o - Notepad does have a rather neat feature called the Undo. In essence,
this is your Oops button. If you make a mistake and suddenly say "Oops", you
can select the Undo and reverse whatever it was you just did. Unless I'm
mistaken, the Undo item will only work on the most recent change you've
made to your document.
C u t - Again, this item is only available if you have something selected in your
document. Otherwise you have nothing to Cut. You can select some piece of
your document by holding down the left mouse button and dragging across the
letters/words/sentences that you want to select. Your selection will have white
letters and a blue background. Now you will be able to Cut this selection. Cut
removes the selected text from your document and puts it on the Clipboard.
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The information is not totally deleted, but is being held in case you want to put
it somewhere else.
C o p y - Copy is very similar to Cut. The only difference is that with Copy,
your selected text is not removed from the document. Instead, a copy of your
selected text is placed on the Clipboard for you to use later.
P a s t e - Once you have some text on the Clipboard (using either Cut or Copy
above), you can move to wherever you would like to put this text and Paste it
back into your document. In other words, the combination of Cut and Paste
allows you to move text around within your document while the combination of
Copy and Paste allows you to duplicate information.
D e l e t e - When you Delete text from your document, it is gone. If you do this
by accident, you can use the Undo function to bring it back, but otherwise it is
gone. Delete does not place the selected text on the Clipboard.
S e l e c t A l l - If there is something you want to do with all the text in your
document at the same time, all you have to do is select the Select All function
and your entire document will be selected. Now you can either Cut or Copy
all the text to your Clipboard.
T i m e / D a t e - The Time/Date function is a neat feature of Notepad. Some
people like to keep a journal and in a journal, you might want to have the date
and time as part of the document. Obviously, you can type in the date and
time, but with the Time/Date function, Notepad will automatically insert the
date and time like this: 7:47 AM 2/27/98.
W o r d W r a p - In the sample of Notepad I showed you earlier, you saw that
the text ran off the edge of the window. In some cases, this is what you want,
but most of the time, you'd like to be able to see all the text on the screen at the
same time. If you only have a little bit of information, you might be able to
enlarge the Notepad window to see all the text. Another way of handling this
is to select the Word Wrap function. This will take words that don't fit in the
Notepad window and wrap them down to the next line.
S e t F o n t . . . - This allows you to change the font used to display the file you
have open. It doesn't change the font of the file itself. It simply allows you to
view/edit files using whatever font you wish.
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Search Menu

This menu contains those functions that allow you to locate specific text within
your document. If your document is short, you may not have a problem
locating specific text, but if it's several pages long, having functions like this
will really come in handy. Again, notice that there is a hot key available for
one of these items.
F i n d . . . - As you've already seen, this function opens a dialog box that allows
you to enter the text you want to search for along with a couple of pieces of
information to help Notepad perform the search. If the text is found, it will be
selected ready for you to Cut, Copy or overtype.

F i n d N e x t - This function simply repeats a previous Find.... This is useful
if you have the same text in several different place within your document. In
conjunction with Copy and Paste, this function would allow you to change
some text globally within your document.
Help Menu

Most programs in Windows have a Help menu that provides information about
using that particular program. The Help menu may not answer all your
questions about a program, but I would encourage you to explore what is there
before you look elsewhere. Most companies marketing software today are
providing more Help and less hardcopy documentation.
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H e l p T o p i c s - Notepad is a very simple program to use as it doesn't
contain a lot of bells and whistles. As a result, the Help Topics is not very
long. You should be able to explore all of Help Topics in just a few minutes. I
would encourage you to do so for two reasons. First, you'll know nearly
everything there is to know about Notepad. Second, you'll become familiar
with the format of the Help facility Microsoft uses so you'll know what to
expect in other Microsoft products.

A b o u t N o t e p a d - The function of the About for any program is simply to
let you know what version of the program you are running. From time to time,
the programmer might include some additional information about your system,
but don't expect this. Here's what my version of About Notepad looks like:
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As you can see, this tells me that I'm running Notepad for Windows 98 and
that it's licensed to me. I get some additional information at the bottom of this
window - the amount of memory I have in my system along with the amount of
system resources I have free.

WordPad



For those who want something more powerful than Notepad, Microsoft makes
available a word processing program called WordPad. WordPad is a basic
word processing application that you can use to quickly create formatted letters,
memos, or any other kind text document. WordPad works with other features
of Windows 95/98 so you can do things like embed graphics into the
documents you create. WordPad comes equipped with some of the basic
features found in larger word processor applications. Some of these features
will allow you to:
•

Create documents with any font that is installed on your system

•

Colorize and change the size of your text

•

Created bulleted lists.

•

Center and justify paragraphs.

One great feature of WordPad is that you can easily open documents you
create with it in other popular word processing software programs such as
Microsoft Word and WordPerfect. This makes it easy to take advantage of the
more complex word processing capabilities of these applications without
retyping your documents.
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Another built-in feature is that WordPad's default text format is the same
format used by Microsoft Word. So if someone sends you a Word document,
you can open the document and see most of its formatting without having Word
installed on your system.
Some people find the power of WordPad to be sufficient for their purposes.
To really appreciate the power of WordPad, you need to experiment with it.
Try typing something into WordPad and then modify it using the different
features available. As soon as you bring up WordPad, you'll notice a couple
of things. First, the layout is very similar to Notepad, which is a good reason
for knowing Notepad before trying to understand WordPad. Second, there are
some definite differences and those differences are what makes WordPad so
powerful.
When we talked about Notepad, I told you the purpose of Notepad was to edit
text files and that you should never use WordPad or a more sophisticated word
processor because of the special characters they put into files. I just want to
repeat that here in case you skipped over that discussion in Notepad. DO
NOT USE WORDPAD TO EDIT TEXT FILES! You will get yourself into
big trouble.
One more thing before we get started with the discussion of WordPad. I will
assume you have read and understand Notepad. Notepad is a starting point
and I will be referring to things I said there from here on. If you came here
without reading about Notepad, I encourage you to go back and get a good
foundation in Notepad first.
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As with Notepad, you have a menu bar across the top of the window. You see
some familiar items (File, Edit and Help) and you see some unique items
(View, Insert and Format). We'll take a look at each of these and see the
differences. Under the menu bar you should see the Standard Toolbar with
some eleven icons on it. We'll look at each of these as well. Under the
Standard Toolbar is the Format Bar with ten additional things. We'll look at
each of these as well. Under the Format Bar is a Ruler that indicates the typing
area. In essence, what you type will remain within the ruler. You have a large
area for typing below the Ruler. At the bottom of the windows is the Status
Bar that will give you some information as you use this tool. Don't worry
about it if you don't see all of these things. You'll learn how to control the
window in a few minutes.
Menu Bar
Before we go to the individual menus, notice something about the menu bar
itself. See the underlined letters in each of the menu items (File, Edit, View,
etc.)? These are meaningful. If you hold down the <Alt> key and press these
letters, you will select that menu. Obviously you can select each menu with the
mouse, but this gives you an alternative way of getting into them. So, you can
get into the File menu by pressing <Alt>F.
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File Menu

Most of what is on the File menu is the same as what you learn with Notepad.
This should make it much easier for you to pick up the new stuff here. Notice
that there are underlined letters on each selection. Although you can select
each item with your mouse, you can do it with the keyboard as well. In this
case, since you are already in the menu, you don't need the <Alt> key; simply
press the underlined letter to select a particular item. Second, notice the "..." at
the end of several selections. This indicates that selecting these items will take
you to a dialog box that will allow you to carry out that operation. Notice that
some of the items in the File menu have a key combination on the right
(Ctrl+N, etc.). These are hot keys that can be used from within the document
without having to go to the File menu. For example, you can start a new
document from within a document by holding down the <Ctrl> key and
pressing the "N" key. I don't recommend that you try and memorize these hot
keys just now. Instead, I would recommend that you just make note of them as
you use the menu items and over time pick up on those you use most
frequently.
New - This will start a new document. If you are currently working on a
document that you haven't saved, the system will prompt you to save the old
document before starting a new one.
Open... - This allows you to bring an existing document into WordPad to
view and/or edit it. You'll see the following dialog box when you make this
selection:
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The only difference between this dialog box and the one you get with Notepad
is that here you are looking for Word for Windows 6.0 (*.doc) files instead of
Text Documents.
Save - If you are making modifications to an existing file, Save will put the
changes back into the file after confirming that you really want to make the
changes. If the file you are working on is a new file, Save works the same as
Save As....
Save As... - Save As brings up a dialog box similar to the Open dialog box
above. By default, WordPad will save a new file in the Windows folder. It's
easy enough to change folders and save a file anywhere on the system you want
though. I would encourage you to create a special place where you save your
files rather than putting them in the Windows folder. See Naming a File on
page 26 for some suggestions on how to organize your data.
Print... - This is a standard print operation sending the information to the
default printer. Contrary to the way Notepad works though, WordPad allows
you to change printers via the following dialog box:
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Print Preview - WordPad offers a neat feature of allowing you to view
your document as it will look when you print it without actually having to print
it. You won't actually be able to read the document, but will be able to see the
layout. The Print Preview will look something like this:

Page Setup... - The Page Setup... dialog box allows you to customize some
of the things you see when you print your document. For example, you can
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change the size of your paper as well as the margin at the top, bottom and either
edge of the paper. The Page Setup... dialog box looks like this:

WordPad provides quick access to the most recently edited document simply
by clicking on the name of the file you want or by typing the number
corresponding to that file.
Send... - This brings up a dialog box that allows you to send the file you're
working on to someone via the Microsoft messaging system. The dialog box
should look like this:
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Exit - This shuts down WordPad. If the file you've been working on has not
been saved, you will be prompted to save the file before WordPad exits.
Edit Menu

The Edit menu contains those functions that allow you to manipulate the
information you have on the screen. As was the case with the File menu, you
have an underlined letter on each item and some hot keys down the right side.
These work the same as they did before. In this case, there are several items
that appear dim in the menu. The reason for this is that these items are not
available at the present time. In most cases, you have to have something
selected for these items to work. Windows does a pretty good job of
communicating with you to tell you what you can and cannot do. Again, take
note of the hot keys available with the Edit menu.
Undo - WordPad has a rather neat feature called the Undo. In essence, this is
your Oops button. If you make a mistake and suddenly say "Oops", you can
select the Undo and reverse whatever it was you just did. Unless I'm mistaken,
the Undo item will only work on the most recent change you've made to your
document.
Cut - This item is only available if you have something selected in your
document. Otherwise you have nothing to Cut. You can select some piece of
your document by holding down the left mouse button and dragging across the
letters/words/sentences that you want to select. Your selection will have white
letters and a blue background. Now you will be able to Cut this selection. Cut
removes the selected text from your document and puts it on the Clipboard.
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The information is not totally deleted, but is being held in case you want to put
it somewhere else.
Copy - Copy is very similar to Cut. The only difference is that with Copy,
your selected text is not removed from the document. Instead, a copy of your
selected text is placed on the Clipboard for you to use later.
Paste - Once you have something on the Clipboard (using either Cut or
Copy above), you can move to wherever you would like to put it and Paste it
back into your document. In other words, the combination of Cut and Paste
allows you to move text around within your document while the combination of
Copy and Paste allows you to duplicate information.
Paste Special... - The Paste Special... function allows you to bring in
information from another file. You can either bring the information in as
separate information or you can insert a link to the other file. If you bring the
information in as separate information, it becomes part of this document
independent of the source of the information. In this case, the information can
be edited by double-clicking on the information and bringing up the application
associated with the information. If the information is inserted via a link, any
changes made to the other file will be reflected in the copied information. The
Paste Special... dialog box will look like this:

Clear - When you Clear text from your document, it is gone. If you do this
by accident, you can use the Undo function to bring it back, but otherwise it is
gone. Clear does not place the selected text on the Clipboard.
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Select All - If there is something you want to do with everything in your
document at the same time, all you have to do is select the Select All function
and your entire document will be selected. Now you can either Cut or Copy
everything to your Clipboard.
Find... - This function opens a dialog box that allows you to enter the text you
want to search for along with a couple of pieces of information to help
WordPad perform the search. If the text is found, it will be selected ready for
you to Cut, Copy or overtype.

Find Next - The Find Next function simply locates the next occurrence of
whatever it is you did the Find... on in the first place.
Replace... - The Replace... function can locate and replace text within your
document. Simply tell Replace... what you want to locate and what you want
to replace it with and WordPad will do the rest.

Links... - If you have information that you have linked into your document
using the Paste Special... function above, then you can perform certain
functions on that link using this function. The Links... dialog box should look
something like this:
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Object Properties - The Object Properties function allows you to do a lot
of the same things you do with the Links... function above. In essence, you're
editing the properties of a linked object and controlling how that object will be
displayed and controlled.
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Object - The appearance of this menu item will change depending on what
you have selected within your document. Essentially, this function allows you
to edit imbedded objects in your document.
View Menu

WordPad allows you to edit several different types of files. Among these are
Text files, Rich Text files, Word 6 documents and Write documents. Each of
these allows something different as far as the content is concerned. As a result,
WordPad allows you to customize the look and feel of WordPad for each of
these types of files.
Toolbar - This is a toggle that allows you to display the standard toolbar
across the top of WordPad.
Format Bar - This is a toggle that allows you to display the format toolbar
under the standard toolbar.
Ruler - This is a toggle that allows you to display the ruler showing you the
typing area for your document.
Status Bar - This is a toggle that allows you to display the status bar at the
bottom of your WordPad window.
Options... - This function brings up a dialog box that allows you to set up the
view you want for each of the different types of files that can be edited with
WordPad. You don't have to have a file open in order to customize WordPad
for a particular type of file. The dialog box you get should look something like
this:
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Insert Menu

Date and Time... - WordPad allows you to maintain a journal similar to
the way Notepad does by allowing you to insert the date and/or time into your
document. Unlike Notepad though, WordPad allows you to control the
format of what you enter. To accomplish this, WordPad will present you a
dialog box that looks like this:

Object... - In addition to inserting the date/time into your document,
WordPad allows you to put a number of different objects into your document
that can help make your document more interesting to read. The objects you
can insert into your document depend on how your system is set up, but the
following is one possibility for inserting an object into your document:
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Format Menu

Basically, the Format menu allows you to control the look of your document by
changing the font, creating lists, controlling the look of your paragraphs and
setting your tab stops.
Font... - The Font... function gives you access to a lot of the same function
you'll find on the format bar. The format bar is probably more convenient if
you have it turned on, but the Font... function puts everything in one dialog
box:
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Bullet Style - This function turns the current paragraph into an unordered
list meaning that it begins with a bullet and is indented from other paragraphs
before and after it. If you begin a new paragraph while in Bullet Style, the new
paragraph will also be in Bullet Style.
Paragraph... - This function allows you to control the indentation of the
current paragraph from the left and right margins as well as the indentation of
the first line of the paragraph. You can also control the alignment of the
paragraph (left, center or right) just as you can from the format bar.
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Tabs... - By default, WordPad gives you a tab stop every half-inch. This
may be satisfactory, but if you'd like to have more control over your tab stops,
look in the Tabs... function. To set a tab at a particular rule location, type in
the position on the ruler and click on Set. To remove a tab stop you no longer
want, select the setting from the list and click on Clear.

Help Menu

Most programs in Windows have a Help menu that provides information about
using that particular program. The Help menu may not answer all your
questions about a program, but I would encourage you to explore what is there
before you look elsewhere. Most companies marketing software today are
providing more Help and less hardcopy documentation.
Help Topics - WordPad contains a few more bells and whistles than
Notepad, but is still simple to use. The Help Topics is a little longer than in
Notepad. It'll take you a little longer to explore all of Help Topics, but I
would encourage you to do so anyway. First, you'll know nearly everything
there is to know about WordPad. Second, you'll become familiar with the
format of the Help facility Microsoft uses so you'll know what to expect in
other Microsoft products.
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About WordPad - The function of the About for any program is simply to
let you know what version of the program you are running. From time to time,
the programmer might include some additional information about your system,
but don't expect this.
Standard Toolbar
You'll notice that all the functions available on the Standard Toolbar are also
available elsewhere in the menus. In essence, the Standard Toolbar gives you
quicker access to frequently used functions.
- This will start a new document. If you are currently working on a
document that you haven't saved, the system will prompt you to save the old
document before starting a new one.
- This allows you to bring an existing document into WordPad to view
and/or edit it.
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- If you are making modifications to an existing file, Save will put the
changes back into the file after confirming that you really want to make the
changes. If the file you are working on is a new file, Save works the same as
Save As....
- This is a standard print operation sending the information to the default
printer. If you don't want to send the printout to the default printer, use the
Print... function in the File menu instead.
- WordPad offers a neat feature of allowing you to view your document
as it will look when you print it without actually having to print it. You won't
actually be able to read the document, but will be able to see the layout.
- This function opens a dialog box that allows you to enter the text you
want to search for along with a couple of pieces of information to help
WordPad perform the search. If the text is found, it will be selected ready for
you to Cut, Copy or overtype.
- This item is only available if you have something selected in your
document. Otherwise you have nothing to Cut. You can select some piece of
your document by holding down the left mouse button and dragging across the
letters/words/sentences that you want to select. Your selection will have white
letters and a blue background. Now you will be able to Cut this selection. Cut
removes the selected text from your document and puts it on the Clipboard.
The information is not totally deleted, but is being held in case you want to put
it somewhere else.
- Copy is very similar to Cut. The only difference is that with Copy,
your selected text is not removed from the document. Instead, a copy of your
selected text is placed on the Clipboard for you to use later.
- Once you have something on the Clipboard (using either Cut or Copy
above), you can move to wherever you would like to put it and Paste it back
into your document. In other words, the combination of Cut and Paste allows
you to move text around within your document while the combination of Copy
and Paste allows you to duplicate information.
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- WordPad has a rather neat feature called the Undo. In essence, this is
your Oops button. If you make a mistake and suddenly say "Oops", you can
select the Undo and reverse whatever it was you just did. Unless I'm mistaken,
the Undo item will only work on the most recent change you've made to your
document.
- WordPad allows you to maintain a journal similar to the way Notepad
does by allowing you to insert the date and/or time into your document. Unlike
Notepad though, WordPad allows you to control the format of what you enter.
Format Bar
- This function allows you to select the
font for any selected text or for any future text. Simply click on the down
arrow at the right and select the desired font.
- This function allows you to select the size for any selected text. The
down arrow at the right will give a list of potential sizes you can choose from.
If the size you would like is not listed, you can type in any size you want.
Obviously your printer needs to support the size you enter, but figures like 150
or 200 are even acceptable.
- This function will make whatever text is selected bold.
- This function will make whatever text is selected italics.
- This function will underline whatever text is selected.
- This function allows you to change the color of whatever text is
selected.
- This function will left align the current paragraph.
- This function will center align the current paragraph.
- This function will right align the current paragraph.
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- This function turns the current paragraph into an unordered list meaning
that it begins with a bullet and is indented from other paragraphs before and
after it. If you begin a new paragraph while in Bullet Style, the new paragraph
will also be in Bullet Style.

Paint



Paint is a very powerful drawing program that allows you to explore your
artistic creativity. With Paint, you can create bitmap (BMP) files that can be
used as wallpaper as we discussed earlier. I'm no artist, but I've managed to
create some neat stuff with Paint.

Let's explore the Paint window and then see how to produce the image I've got
above.
Menu Bar
Before we go to the individual menus, notice something about the menu bar
itself. See the underlined letters in each of the menu items (File, Edit, View,
etc.)? These are meaningful. If you hold down the <Alt> key and press these
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letters, you will select that menu. Obviously you can select each menu with the
mouse, but this gives you an alternative way of getting into them. So, you can
get into the File menu by pressing <Alt>F.
File

Most of what is on the File menu is the same as what you learn with Notepad
and WordPad. This should make it much easier for you to pick up the new
stuff here. Notice that there are underlined letters on each selection. Although
you can select each item with your mouse, you can do it with the keyboard as
well. In this case, since you are already in the menu, you don't need the <Alt>
key; simply press the underlined letter to select a particular item. Second,
notice the "..." at the end of several selections. This indicates that selecting
these items will take you to a dialog box that will allow you to carry out that
operation. Notice that some of the items in the File menu have a key
combination on the right (Ctrl+N, etc.). These are hot keys that can be used
from within the document without having to go to the File menu. For example,
you can start a new document from within a document by holding down the
<Ctrl> key and pressing the "N" key. I don't recommend that you try and
memorize these hot keys just now. Instead, I would recommend that you just
make note of them as you use the menu items and over time pick up on those
you use most frequently.
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New - This will start a new bitmap document. If you are currently working on
a bitmap that you haven't saved, the system will prompt you to save the old one
before starting a new one.
Open... - This allows you to bring an existing bitmap into Paint to view
and/or edit it. You'll see the following dialog box when you make this
selection:

Save - If you are making modifications to an existing file, Save will put the
changes back into the file after confirming that you really want to make the
changes. If the bitmap you are working on is a new file, Save works the same
as Save As....
Save As... - Save As... brings up a dialog box similar to the Open dialog box
above. By default, Paint will save a new file in the Windows folder. It's easy
enough to change folders and save a file anywhere on the system you want
though. I would encourage you to create a special place where you save your
files rather than putting them in the Windows folder. See Naming a File on
page 26 for some suggestions on how to organize your data.
Print Preview - Paint offers a neat feature of allowing you to view your
bitmap as it will look when you print it without actually having to print it. You
won't actually be able to see the bitmap, but will be able to see the layout. The
Print Preview will look something like this:
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Page Setup... - The Page Setup... dialog box allows you to customize some
of the things you see when you print your bitmap. For example, you can
change the size of your paper as well as the margin at the top, bottom and either
edge of the paper. The Page Setup... dialog box looks like this:
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Print - This is a standard print operation sending the information to the default
printer. Contrary to the way Notepad works though, Paint allows you to
change printers via the following dialog box:
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Send... - This brings up a dialog box that allows you to send the file you're
working on to someone via the Microsoft messaging system. The dialog box
should look like this:

Set As Wallpaper (Tiled) - This function saves you the hassle of saving
the bitmap and then setting it as the wallpaper on your desktop. This does it all
in one operation. In this case, the bitmap is tiled meaning that it is repeated to
cover the entire desktop.
Set As Wallpaper (Centered) - This function saves you the hassle of
saving the bitmap and then setting it as the wallpaper on your desktop. This
does it all in one operation. In this case, the bitmap is centered rather than tiled
as is the case in the previous item.
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Paint provides quick access to the most recently edited bitmaps simply by
clicking on the name of the file you want or by typing the number
corresponding to it.
Exit - This shuts down Paint. If the bitmap you've been working on has not
been saved, you will be prompted to save it before Paint exits.
Edit

The Edit menu contains those functions that allow you to manipulate the
information you have on the screen. As was the case with the File menu, you
have an underlined letter on each item and some hot keys down the right side.
These work the same as they did before. In this case, there is one item that
appears dim in the menu. The reason for this is that this items is not available
at the present time. In this case, you can only Repeat what you have Undone.
Windows does a pretty good job of communicating with you to tell you what
you can and cannot do. Again, take note of the hot keys available with the Edit
menu.
Undo - Paint has a rather neat feature called the Undo. In essence, this is
your Oops button. If you make a mistake and suddenly say "Oops", you can
select the Undo and reverse whatever it was you just did. The Undo item will
only work on the three most recent changes you've made to your bitmap.
Repeat - Since the Undo item is your Oops button, the Repeat could
probably be referred to as the Double Oops button. Essentially what it does is
to reverse what the Undo did. If you made a change and suddenly decided you
didn't want that change and pressed the Undo button only to realize that you
really did want the change, you can use the Repeat function.
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Cut - This item is only available if you have something selected in your
bitmap. Otherwise you have nothing to Cut. You can select some piece of
your bitmap by clicking on either of the first two items on the Toolbar and
drawing a box around whatever you want to select. Your selection will have a
dotted box around it. Now you will be able to Cut this selection. Cut removes
the selected area from your document and puts it on the Clipboard. The
information is not totally deleted, but is being held in case you want to put it
somewhere else.
Copy - Copy is very similar to Cut. The only difference is that with Copy,
your selected area is not removed from the bitmap. Instead, a copy of your
selected area is placed on the Clipboard for you to use later.
Paste - Once you have something on the Clipboard (using either Cut or
Copy above), you can move to wherever you would like to put it and Paste it
back into your bitmap. In other words, the combination of Cut and Paste
allows you to move an area around within your bitmap while the combination
of Copy and Paste allows you to duplicate it.
Clear Selection - This function removes whatever you have selected from
your bitmap. It does not place the selected area on the Clipboard. If you do
this by accident, you can use the Undo function to bring it back, but otherwise
it is gone.
Select All - If there is something you want to do with your entire bitmap at
the same time, all you have to do is select the Select All function and your
entire bitmap will be selected. Now you can either Cut or Copy everything to
your Clipboard.
Copy To... - The Copy To... function takes whatever part of your bitmap you
have selected and makes a copy of it and allows you to store that copy into a
file.
Paste From... - The Paste From... function allows you to bring another
bitmap image file into the bitmap on which you are currently working.
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View

Paint provides you with several tools to help you create your bitmap. These
tools are user controllable through the View menu.
Tool Box - This is a toggle that allows you to display the Tool Bar normally
down the left side of Paint. When the command has a check mark next to it,
the Tool Bar is on.
Color Box - This is a toggle that allows you to display the Color Bar at the
bottom of the Paint window. A check mark appears when the Color Bar is
visible.
Status Bar - This is a toggle that allows you to display the Status Bar at the
bottom edge of the Paint window. When the command has a check mark next
to it, the Status Bar is on.
Zoom - Notice the wedge to the right of the Zoom item. This indicates that
there is more to this menu item and that just pausing your mouse on it will
show the next level of it. You can control the amount of zoom along with a
couple of additional things while you're in zoom mode.
View Bitmap - This will allow you to view your bitmap as a full screen.
This is a neat function, but doesn't give you any indication on how to get out of
the function and back to Paint. The secret is to click the left mouse button
anywhere on the screen and you're immediately back into Paint.
Text Toolbar - This function toggles the Text Toolbar on or off. This is
only available when you are working with text in your bitmap.
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Image

Flip/Rotate... - This function allows you to flip your bitmap or a portion of
your bitmap either horizontally or vertically or rotate your image 90 º, 180 º or
270 º. The dialog box you'll see will look something like this:

Stretch/Skew... - This function allows you to stretch your bitmap or a
portion of your bitmap horizontally or vertically by some percentage. It also
allows you to skew you image horizontally or vertically by so many degrees.
This dialog box will look like this:
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Invert Colors - When you select this function, each color is replaced by its
color complement. For example, white becomes black, and red becomes blue.
Attributes... - This function allows you to specify the size and color of your
overall bitmap. The size controls the white area of the image screen. This
allows you to specify very precise sizes for your images. You cannot use this
function for an existing bitmap. When you change the attributes, you will start
a new bitmap. The dialog box will look like this:

Clear Image - This function will erase everything in the current bitmap and
allow you to start over.
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Options

Edit Colors... - This function allows you to create custom colors. For
example,
1. In the Color Box, click the color you want to change.
2. On the Options menu, click Edit Colors....
3. Click Define Custom Colors, and then enter new values in either the
RGB (red, green, blue) or HLS (hue, saturation, and luminescence)
color models.
4. Click Add to Custom Colors.

To save your custom colors, click the Options menu, and then click Save
Colors.... To use your saved colors, click Get Colors.... For Help on an item,
click the ? at the top of the dialog box, and then click the item.
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Get Colors... - If you have created custom colors and saved them, you can
bring them in later to use with another bitmap by using this function. You'll
see a dialog box similar to the Save Colors... dialog box.
Save Colors... - If you have created custom colors, you can save them for
use in other bitmaps later. When you select this function, you'll see the
following dialog box:

Draw Opaque - With Paint, you can either draw transparent (specifies that
the existing picture will show through your selection and the background color
of your selection will not be displayed) or opaque (specifies that your select
will cover the existing picture, using the foreground and background colors of
the selected object). To choose transparent drawing, make sure Draw Opaque
is not checked. To choose opaque drawing, make sure Draw Opaque is
checked.
Help

Most programs in Windows have a Help menu that provides information about
using that particular program. The Help menu may not answer all your
questions about a program, but I would encourage you to explore what is there
before you look elsewhere. Most companies marketing software today are
providing more Help and less hardcopy documentation.
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Help Topics - Paint contains a few more bells and whistles than Notepad,
but is still simple to use. The Help Topics is a little longer than in Notepad.
It'll take you a little longer to explore all of Help Topics, but I would
encourage you to do so anyway. First, you'll know nearly everything there is to
know about Paint. Second, you'll become familiar with the format of the Help
facility Microsoft uses so you'll know what to expect in other Microsoft
products.

About Paint - The function of the About for any program is simply to let
you know what version of the program you are running. From time to time, the
programmer might include some additional information about your system, but
don't expect this.
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ToolBar
- This icon allows you to select an irregularly shaped object from your
picture in order to cut/copy it somewhere else either within your picture or to
another application.
- This icon allows you to select a rectangular section of your picture in
order to cut/copy it somewhere else either within your picture or to another
application.
- This icon will turn your cursor into a little square. By holding down the
left mouse button and dragging the mouse across sections of your picture, you'll
reset the image to the background color. You can control the size of the eraser
with the selection box that appears at the bottom of the ToolBar.
- As this icon implies, you can use it to dump color into your picture. The
color you put into your picture can be selected from the Color Bar normally at
the bottom of the window.
- This icon looks like an eyedropper that can be used to pick up a color
from one place in your picture and put it somewhere else. Once you have used
the eyedropper to pick up a color, you will be automatically switched to the
paint icon above to dump this color into another part of your picture.
- This icon allows you to draw freehand. Essentially you get a pencil and
by holding down the left mouse button, you can draw whatever you want in
your picture.
- This icon allows you to magnify the picture you are working on. You
can increase the size of the picture two times, six times or eight times. This can
be very useful if you are doing some very fine work and need precise control.
This only changes the view of the picture and not the actual size of the picture.
- This icon acts as a paintbrush allowing you to paint the color select on
the Color Bar onto your picture in a number of different patterns.
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- This icon looks like a paint spray can and works pretty much the same
way. As you hold down the left mouse button, you will spray the color selected
onto your picture. The longer you hold the mouse button down over the same
place, the darker the color becomes.
- This icon allows you to add text to your picture. Once activated, your
mouse will turn to crosshairs allowing you to create a rectangular section of
your picture where you want to put some text. You should then get a font
toolbar that allows you to adjust the font, size, etc of the text you want to use.
You can then simply type in the text you want. It's not always that easy to get
just the right effect in your picture so you might want to save a copy of your
picture in case it doesn't turn out the way you want.
- This icon allows you to draw a straight line in Paint. To choose the
width the line will be, click a line width from the bottom of the ToolBar. To
choose the color the line will be, click a color. Simply click at the beginning of
a line and release at the end of the line. Paint does the rest. Use the left mouse
button to draw with the foreground color or the right mouse button to draw with
the background color. To draw a perfectly horizontal, vertical, or 45-degree
diagonal line, press and hold down the <Shift> key while dragging the mouse
pointer.
- This icon is tricky. To choose the width the curve will be, click a line
width at the bottom of the ToolBar. To choose the color the curve will be, click
a color. First draw a straight line as above. Click where you want one arc of
the curve to be, and then drag the mouse pointer to adjust the curve. Each
curve must have at least one arc but no more than two. Repeat this step for a
second arc. Use the left mouse button to draw with the foreground color or the
right mouse button to draw with the background color. To undo a change, click
Edit and then click Undo. You can undo up to three changes.
- This icon allows you to draw a rectangle. Click a color from the color
box for the shape's outline. To fill the shape with color, click a color by using
the right mouse button, and then click a fill style from the bottom of the
ToolBar. To draw a rectangle, drag the mouse pointer diagonally in the
direction you want. As you do, Paint will draw a rectangle for you. To draw a
square, press and hold down the <Shift> key while dragging the mouse pointer.
You have a couple of options you'll see at the button of the ToolBar when you
start using this icon. You can simply draw a rectangle with all other lines still
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visible behind, you can draw a rectangle and not be able to see the lines behind,
or you can simply shade an area with your background color.
- This icon allows you to draw a series of connecting line. To create a
colored fill, click a color by using the right mouse button, and then click a fill
style from the bottom of the tool box. To draw the polygon, drag the mouse
pointer and click at each corner. Double-click when you're done. To use only
45- and 90-degree angles, press and hold down the <Shift> key while dragging
the mouse pointer. To undo a change, click Edit and then click Undo. You
can undo up to three changes.
- This icon allows you to draw an ellipse or circle. Click a color from the
color box for the shape's outline. To fill the shape, click a color by using the
right mouse button, and then click a fill style from the bottom of the ToolBar.
To draw an ellipse, drag the mouse pointer diagonally. To draw a perfect
circle, press and hold down the <Shift> key while dragging the mouse pointer.
To undo a change, click Edit and then click Undo. You can undo up to three
changes.
- This icon works just like the
produced have rounded corners.

icon above except that the rectangles

Color Bar

- The Color Bar can be used to select
both foreground and background color for whatever you are working on. The
foreground color can be selected simply by using the left mouse button to select
a color. The background color is selected using the right mouse button.

Character Map
The Character Map allows you to view all of the various fonts that you have
installed on your computer and to use these in other Windows applications.
Some examples of some characters available through Character Map include:
☺
As you can see, the Character Map can be a very powerful tool.
The PC Help Desk

82

7/7/04

I N T R O D U C T I O N

T O

W I N D O W S

9 8

The Wingdings font is one of my favorite fonts. It provides characters not
available on the standard keyboard. By using these characters, you can
enhance your documents and make them much more interesting. If you singleclick on any of the characters, it'll blow up so you can get a good look at it. If
you double-click on a character, it will be copied to Characters to copy in
preparation for putting them into your document. Once you have characters in
the Characters to copy area, you can click on the Copy button to place these
characters on the Clipboard so you can Paste them into another application.

Clipboard
The Clipboard is essential a shelf within Windows that can hold one object at
a time. An object can be a letter, word, paragraph and/or graphic. An object can
be placed on the Clipboard from any Windows application. That same object
can then be placed into any Windows application repeatedly until the contents
of the Clipboard are replaced. Operations dealing with the clipboard include:
Cut - Removes the selected object or text and places it on the Clipboard so you
can paste it elsewhere.
Copy - Makes a copy of the selected object or text and places it on the
Clipboard so you can paste it elsewhere.
Paste - Inserts the object or text that is on the Clipboard. This command is
available only if you have cut or copied an object or text.
There is a program called the Clipboard Viewer that allows you to work with
the contents of the Clipboard.
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Let's look at some of the features of the Clipboard Viewer. Let's start off by
looking at each of the menus across the top of the Clipboard Viewer. Before
we go to the individual menus, notice something about the menu bar itself. See
the underlined letters in each of the menu items (File, Edit, Display, etc.)?
These are meaningful. If you hold down the <Alt> key and press these letters,
you will select that menu. Obviously you can select each menu with the
mouse, but this gives you an alternative way of getting into them. So, you can
get into the File menu by pressing <Alt>F.
File Menu

This is the File menu. Notice a couple of things about this menu. First, notice
that there are underlined letters on each selection. Although you can select each
item with your mouse, you can do it with the keyboard as well. In this case,
since you are already in the menu, you don't need the <Alt> key; simply press
the underlined letter to select a particular item. Second, notice the "..." at the
end of the Open... and Save As... items. This indicates that selecting these
items will take you to a dialog box that will allow you to carry out that
operation.
O p e n . . . - This allows you to bring an existing Clipboard file into the
Clipboard Viewer. You'll see the following dialog box when you make this
selection:
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S a v e A s . . . - Save As... brings up a dialog box similar to the Open... dialog
box above. By default, the Clipboard Viewer will save a new file in the
Windows folder. It's easy enough to change folders and save a file anywhere
on the system you want though. I would encourage you to create a special
place where you save your files rather than putting them in the Windows
folder. See Naming a File on page 26 for some suggestions on how to
organize your data.
E x i t - This shuts down the Clipboard Viewer.
Edit Menu

There is not a lot of editing you can do with the Clipboard. As a result, this
menu is very simple. As was the case with the File menu, you have an
underlined letter on each item and a hot key to the right. This works the same
as they did before.
D e l e t e - Delete will first ask you if you are sure you want to empty the
contents of the Clipboard and will then do it. Very simple.
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Display Menu

This menu contains those functions that allow you to display the contents of the
Clipboard in several different formats. This menu will change depending on
the type of data the Clipboard contains. As a result, it would be difficult for
me to cover all the various options. Instead, I'll let you explore this on your
own. The menu shown above is for when the Clipboard contains text
information.
Help Menu

Most programs in Windows have a Help menu that provides information about
using that particular program. The Help menu may not answer all your
questions about a program, but I would encourage you to explore what is there
before you look elsewhere. Most companies marketing software today are
providing more Help and less hardcopy documentation.
H e l p T o p i c s - The Clipboard Viewer is a very simple program to use as it
doesn't contain a lot of bells and whistles. As a result, the Help Topics is not
very long. You should be able to explore all of Help Topics in just a few
minutes. I would encourage you to do so for two reasons. First, you'll know
nearly everything there is to know about the Clipboard Viewer. Second, you'll
become familiar with the format of the Help facility Microsoft uses so you'll
know what to expect in other Microsoft products.
The PC Help Desk

86

7/7/04

I N T R O D U C T I O N

T O

W I N D O W S

9 8

A b o u t C l i p b o a r d V i e w e r - The function of the About for any program is
simply to let you know what version of the program you are running. From
time to time, the programmer might include some additional information about
your system, but don't expect this. Here's what my version of About
Clipboard Viewer looks like:

The PC Help Desk

87

7/7/04

I N T R O D U C T I O N

T O

W I N D O W S

9 8

As you can see, this tells me that I'm running Clipboard Viewer for Windows
95 and that it's licensed to me. I get some additional information at the bottom
of this window - the amount of memory I have in my system along with the
amount of system resources I have free.

Clock
Most computers come with a built-in clock. This clock is used by the system to
prioritize files and operations. Every file that is stored on the computer carries
not only the name of the file, but the size, date and time the file was created or
last modified. Windows 95/98 provides a means for displaying the clock as
well as changing the clock. To adjust the clock, double-click on the clock on
your Taskbar.
By double-clicking on the time on the Taskbar, you can change the date and
time for your computer through an easy-to-use dialog box.
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Calculator
The Calculator can be a very powerful tool if you need to do some quick
calculations and don't have you hand calculator handy. It also contains some
very powerful features that aren't available on a lot of regular calculators.
The Calculator normally comes up in the Standard mode which is what most
people will use. In this mode, you have the most common functions including
memory, square root, percentage and reciprocal. The calculator also contains a
Scientific mode which gives you access to many more functions. Don't be
afraid to explore this tool as you may never need you hand calculator again as
long as you're working on your computer.
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With much of the Standard view of the Calculator, I assume everyone is
already familiar with what you have available. As a result, I'll skip the basics
of how a calculator works and concentrate on what makes this unique from a
regular calculator. The only key that is probably unique on the above view is
the Back key. This is essentially a backspace key. Let's look at each of the
menus across the top of the Calculator. Before we go to the individual menus,
notice something about the menu bar itself. See the underlined letters in each
of the menu items (Edit, View and Help)? These are meaningful. If you hold
down the <Alt> key and press these letters, you will select that menu.
Obviously you can select each menu with the mouse, but this gives you an
alternative way of getting into them. So, you can get into the Edit menu by
pressing <Alt>E.
Edit Menu

This is the Edit menu. Notice a couple of things about this menu. First, notice
that there are underlined letters on each selection. Although you can select each
item with your mouse, you can do it with the keyboard as well. In this case,
since you are already in the menu, you don't need the <Alt> key; simply press
the underlined letter to select a particular item.
C o p y - Copy takes a copy of the value you have displayed and places it on the
Clipboard for you to use later.
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P a s t e - Once you have something on the Clipboard (using either Cut or
Copy above), you can Paste it back into the Calculator. In other words, the
combination of Cut and Paste allows you to move a value while the
combination of Copy and Paste allows you to duplicate it.
View Menu

S c i e n t i f i c – This shows you the scientific view of the Calculator which is
much more complex than the Standard view. It contains many more functions
and the ability to work is the binary, octal and hexadecimal numbering systems
as well as decimal.
S t a n d a r d – This shows the normal view for the Calculator. This is the view
that is shown at the start of this section and the one that most people will use.
It contains all the functions that most people will need when working on the
computer.
Help Menu

H e l p T o p i c s - The Calculator is a very simple program to use as it doesn't
contain a lot of bells and whistles. As a result, the Help Topics is not very
long. You should be able to explore all of Help Topics in just a few minutes. I
would encourage you to do so for two reasons. First, you'll know nearly
everything there is to know about the Calculator. Second, you'll become
familiar with the format of the Help facility Microsoft uses so you'll know what
to expect in other Microsoft products.
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A b o u t C a l c u l a t o r - - The function of the About for any program is simply
to let you know what version of the program you are running. From time to
time, the programmer might include some additional information about your
system, but don't expect this. Here's what my version of About Calculator
looks like:
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As you can see, this tells me that I'm running Calculator for Windows 98 and
that it's licensed to me. I get some additional information at the bottom of this
window - the amount of memory I have in my system along with the amount of
system resources I have free.
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Shortcuts Hints and Tips
There are a number of shortcuts, hints and tips that can really increase the
power of this operating system. Let's take a look at some of these.

Taskbar
The Taskbar is a powerful part of Windows 98. It provides access to nearly
every part of your system as well as providing information about what is
running on your system. But it can get in the way. Fortunately, you can move
it out of your way by moving it to another edge of your screen or you can hide
it altogether.
First, you can move the Taskbar to any side of the screen simply by dragging
it to a different side of the screen. This allows you to get it out of your way
while still keeping it visible. When you click and drag the Taskbar, be sure to
click on the Taskbar itself and not on an icon.
Second, you can hide the Taskbar by
1. Click on the Start button.
2. Point to Settings.
3. Click on Taskbar & Start Menu.... You'll get a dialog box entitled
Taskbar Properties.
4. The bottom portion of this window contains four items. The second is
Auto hide. Click the left mouse button on this item and a check mark
will appear in the box to the left of it.
5. Now click the OK button at the bottom of the Window. The Window
closes and your Taskbar goes away.
Now that your Taskbar is gone, don't panic. It's still available when you need
it. All you need to do is move your mouse down to the bottom of your screen.
As you touch the bottom of the screen, the Taskbar will pop up for you to use.
When you move off the Taskbar, it will hide again.

Start Menu
Newcomers to Windows accept the Start menu as a fixed, unchangeable list of
programs. This simply is not the case. Of course you can add new programs to
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the Start menu when you install them, but you may also want to modify the
Start menu to suit your taste.
You can right click on any item in the Start menu and move it, copy it, delete
it, change its properties etc.
To move or copy an item from your desktop to the Start menu, just drag it over
the Start icon, and the Start menu will open up. Drop it wherever you want it
in the Start menu.

Send To
When you right-click on a file in the Explorer or My Computer, the context
sensitive menu you get shows you what you can do with the file you’ve clicked
on. One of the items listed is Send To. The system maintains this pretty well,
but you may find that you’d like to have something in the Send To menu that
Windows has not placed there for you.
To add Notepad to the menu (for example):
1. Open Explorer and Go to C:\WINDOWS\SENDTO folder.
2. Click File, New, Shortcut and Click on the Browse button.
3. Find Notepad.exe in your Windows directory.
4. Click Open, Next, Finish.
You'll have Notepad in your Send To Menu.
Similarly you can add other programs to the Send To menu.

<Ctrl><Esc>
If your Start button isn't readily available or you don't want to use the mouse,
you can bring up the Start menu by pressing <Ctrl><Esc>. You can then use
your cursor keys to navigate the menu.
Here's a little trick I hope you'll never need. Working with Windows 98 is
easy. All you need to do is point your mouse at the Start button and you can
get to anything on your system, right? Well, true, but what happens if your
mouse quits working. It can happen. Without your mouse, you can do just
about anything on your system including properly shutting it down. Although
Microsoft has geared everything to the mouse, it didn't forget that there are
some people out there who have problems with the mouse every once in a
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while. If you hold the <Ctrl> key down and tap the <Esc> key, you'll pop up
the Start menu. You can then use your cursor keys to select things. As I
say, I hope you never need this, but it's nice to keep this in the back of your
mind just in case.
If your keyboard is a Windows 95 compatible keyboard, you have a few extra
keys on it that weren’t on earlier keyboards. For example, you may have a key
between the <Ctrl> and <Alt> keys to the left of the Space bar. This is the
<Window> key. You also have one of these to the right of your Space bar as
well. If you simply press the <Window> key by itself, you’ll pop up the Start
menu. This gives you an even quicker way of getting to the Start.

Hard Disk Maintenance
Your computer is like a car - it requires maintenance to continue to run
properly. Your system comes with a couple of programs to help with this
maintenance. Always check your hard disk for errors before optimizing.
Scandisk - checks your hard disk for errors
Defrag - optimizes hard disk file structure
One of the problems that has been inherent in computers for a long time is that
data that stored on them ends up fragmented. I won't go into the details of how
this happens, but as the data on your hard disk gets fragmented, your computer
will run slower and slower until eventually it will stop altogether. Before
Windows 95, the only way to correct this situation was to get out of Windows
and use some not-so-user-friendly programs called SCANDISK and DEFRAG to
clean things up. These tools come with DOS v6.0 or later. With Windows 95,
Microsoft has beefed up these necessary tools so they now run under Windows.
They still give you some rather cryptic messages when errors are detected, but
it's now possible for anyone to run these tools. Both of these tools are located
in the System Tools group inside the Accessories group. You'll find
ScanDisk and Disk Defragmenter in here. For the most part, these
tools are easy to use, but there are too many options to go into detail here.
Rather than expanding this document into a volume, let me suggest you get
some additional help on the specifics of these tools. I would like to point out
that it's imperative that you run ScanDisk before you run the Disk
Defragmenter.
Windows 98 comes with something called the Task Scheduler that
automatically runs ScanDisk and Disk Defragmenter at times you specify.
You should see an icon in the Systray on the Taskbar for the Task Scheduler.
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To set things up to run Scandisk and Disk Defragmenter automatically, look
in Accessories, System Tools for something called the Maintenance Wizard.
It will walk you through setting things up. I might remind you that in order for
this to work at the time you specify, your computer must be turned on and you
cannot be using it. If you’re using it, the Task Scheduler will simply postpone
the maintenance until it finds you not using the computer.

Working with Documents
When you use the computer, you will normally create or modify data. When
you save this data, it will be placed in a file or document. Documents come in
a variety of types: bitmaps, textual, word processing files, etc. Each type of file
is associated with a particular program by Windows. For example, bitmap files
are associated with Paint, textual files are associated with Notepad, etc.
In order to understand the importance of this concept, let's bring up Notepad.
You'll find it in the Accessories group. Once you have Notepad up, open a file
called General located in the Windows folder. This particular file contains
some useful information about Windows 98. You can read it later. Now close
Notepad.
The process you just performed seems natural enough, but it's rather involved
particular if the file you were after was somewhere other than your Windows
folder. Now that we've opened this file, let's do it again, but this time using a
different procedure.
Click on the Start button and move your mouse up to Documents. Pausing on
Documents will open a list of the fifteen most recently opened documents.
Click on the General document. Notepad will start and the General file will
automatically be loaded.
You have just experienced the benefit of file association. If the file you want to
work with is in Documents, you can bring it up in the appropriate program
very quickly by clicking on it here. If the file is not listed in Documents, but
you know where it is, you can use My Computer or the Explorer to locate it
and double-click on it. If you know the name of the file, but not where it is
located, you can use the Find facility to locate the file and double-click on it.

Using the Mouse
Most people who have used an earlier version of Windows are familiar with
the basic use of the mouse. You use the left mouse button to single-click on
something to select it, double-click on something to activate it, or click and
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drag something. The operations are still available in Windows 95/98, but
Windows 95/98 also implements the right mouse button by providing a context
sensitive menu of functions you can perform wherever you use it.
To demonstrate the power of the right mouse button, let's use it with the file
we've been working with recently - the General textual file in the Windows
folder. Bring up the Explorer and look in the Windows folder for the General
file. Right-click on this file and you should see something like the following
menu:

This menu contains those operations that are available for use against the object
currently selected. All of these operations are available elsewhere, but
Windows 95/98 makes them convenient. The right mouse button is available
everywhere in Windows 95. The content of the menu will change depending
on where you use it, but it will always give you those operations that are
available for the object you have selected.

User Profiles
If more than one person uses the same computer, you can set up user profiles so
that when one person logs on, their personal Windows settings are used. For
example, you could have your own desktop colors, icons, and program groups
appear when you log on to Windows, but if someone else logs on, their settings
appear instead.
To set up user profiles, double-click the Passwords icon in the Control Panel.
To establish individual user profiles on the same system,
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1. Click the Start button.
2. Move the mouse up to Settings and then to the right to Control Panel
and click.
3. Double-click on the Passwords icon. The Passwords Properties
dialog box appears.
4. Click the User Profiles tab.
5. Select the Users can customize their preferences and desktop
settings option.
6. You might also consider clicking on the User Profile Settings buttons.
7. Click the OK button. A System Settings Change dialog box appears.
Click the No button.
8. Close the Control Panel.
9. Select Shut Down... from the Start menu. The Shut Down Window
dialog box appears.
10. Select the Close all programs and log on as a different user? option
and click the Yes button.
A new account will be established for each person logging on the system.
One word of caution is appropriate about user profiles and passwords.
Establishing user profiles and passwords does not prevent someone from
getting on your computer. All it does is to prevent someone from getting into
your configuration and making changes to it. There are two ways in which
someone can get onto your computer without your password. First, when you
get the log on screen, by pressing the <Esc> key, you can get onto the system
using the default system configuration. Second, anyone can type in their own
name and a password and create a user profile.

Restarting Windows
Windows 95/98 needs to be restarted from time to time. Microsoft even
recognized this by putting an option in the Shut Down... menu called
Restart the Computer?. This option does a warm boot of the system
meaning that it goes through everything except the power-on diagnostic check.
This can take a while depending on your system.
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If you hold down the key after clicking on Restart the Computer? and
then click Yes, the computer will only restart Windows which can be done
fairly rapidly instead of taking the long route. You do need to hold the key
down until the system acknowledges what you want and starts bringing up
Windows again.

Registry
Before upgrading to Windows 95, did you use SysEdit to make changes to
your CONFIG.SYS, AUTOEXEC.BAT, SYSTEM.INI and WIN.INI files? It
was a very powerful tool, wasn't it? What ever happened to it?
Well, I have some good news and some bad news for you.
The good news
☺ is that SysEdit is still there and you can access it through the Start
menu, Run... and typing in SysEdit. The bad news is that you need to
be careful because Windows 95/98 has changed things a bit on you and you
might do more damage by making changes to these files than you will cure.
Windows 95/98 has something new called the Registry. The Registry takes
the place of and supplements what use to be in WIN.INI and SYSTEM.INI.
Windows 95/98 tries to maintain some consistency for the sake of old 16-bit
applications, but I wouldn't bet on everything being the same. As a matter of
fact, the Windows 95/98 version of SysEdit will actually block you from
changing some things in these files because it interferes with the way it does
things. Instead of using SysEdit, let me recommend that you use RegEdit.
It works with the Registry. A word of caution is in order here as well though.
If you don't know about the Registry, don't mess with it. It's not a single file
that you can back up in case you screw things up. It's a database drawn from
many places in your system. Learn about the Registry before you try to make
changes to it.

Rescue Diskette
In Windows 95/98, as in Win3.1x, installation of new applications sometimes
renders your system unbootable. To help in these situations, create a bootable
"rescue" floppy disk. Insert a diskette that's either blank or contains nothing
you need. Click on the Start button, go to Settings and then to the
Control Panel. Double-click on the Add/Remove Programs icon.
Click on the Startup Disk tab then click on Create Disk. When
Windows 95/98 is done, make the disk read-only, label it and test it to be sure
you can boot your computer from it. To be extra safe, make two boot disks.
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Windows 98 Tips
In your WINDOWS folder, you'll find a text file called General full of tips
and tricks written by the Microsoft's Windows 98 development team. A lot of
the information contained in this file is technical in nature and may not apply to
your computer. For simpler and more pertinent information, don’t overlook the
Help facility. Click on Start and then on Help. Take your time to explore
some of the information available here as this is the best way to learn your way
around Windows.

Creating Icons and Hotkeys
As you may already know, you have many icons on your desktop and in the
Start menu that give you access to things on your system. As you work with
your system, you will add others as part of the normal operation of your
system. Most people begin to wonder how they can create their own icons or
delete some of those they have and no longer want. This is the topic of this
section.

Warning: This is an advanced topic and if you don't already feel comfortable
with Windows 95/98, I would encourage you not to tackle this until you've
been through the rest of this book.
It's impossible for me to know exactly what sort of an icon you want to create
so let me pick one to use as an example. Suppose I want to access WordPad
easily. There are actually several different ways in which we can create an icon
for just about anything, but perhaps the easiest way of explaining this is to tell
you that the program you run when you bring up WordPad is called wordpad
so let's go find that program. Go to the Start menu and point Find and then
click on Files or Folders.... Type in "wordpad" in the Named: field and click
on Find Now. The result will be a list of files with the name of "wordpad".
One of these files will be an Application. Right-click on this wordpad file and
drag it to your desktop. When you release the right mouse button, you'll get a
context sensitive menu containing your options. Select Create Shortcut(s)
Here. You have just created a shortcut to WordPad. Now let's take this a
couple of steps further.
The name of the shortcut we've created is "Shortcut to Wordpad". This is
okay, but I think it would be more meaningful if we changed the name to just
"WordPad" instead. To do this, right-click on the icon and select Rename
from the context sensitive menu that you get. This will allow you to change the
name and type in "WordPad" in place of "Shortcut to Wordpad". There!
That's better. At this point, you might like to check to make sure the shortcut
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we've created really works. Try double-clicking on it to make sure WordPad
comes up.
Using this new WordPad icon is only slightly better than clicking on the Start
button, moving to Programs, Accessories and then clicking on WordPad.
Normal access to WordPad would require a click, moving the mouse until you
get to WordPad and then clicking again. Our new icon requires a doubleclick. You still have to take you hand off the keyboard, grab the mouse and use
it to activate WordPad. Suppose we make another change here that will allow
us to bring up WordPad without using the mouse.
Right-click on the icon again and select Properties this time. This brings up
the WordPad Properties dialog box which allows us to specify how
WordPad will run when we use this icon. Notice the Target: and Start in:
fields. The Target: field specifies the name and location of the program that is
going to be executed. Note that WordPad is in the Program Files,
Accessories folder. The Start in: field specifies where WordPad will look
initially for any files you want to load or save. Since we set up a special area in
which to put our data (see Naming a File on page 26), let's change the Start
in: field to point to C:\Data. Now, look at the Shortcut key: field. This
allows us to specify a key that we can use to activate this shortcut. Go to this
field and just press the "w" key. Notice that the field becomes "Ctrl + Alt +
W". In other words, in order to activate this icon, we need to hold down the
<Ctrl> and <Alt> keys and press the W key. Okay, now click on OK. Try
pressing <Ctrl><Alt>w and see if WordPad comes up.
Let's project this concept out a ways. I can foresee creating a bunch of
shortcuts like this. Before long, it might be difficult to remember all the
shortcuts you create even if you make them meaningful like the
<Ctrl><Alt>W for WordPad. Suppose we create a WordPad file that will
contain all the shortcuts we create along with what they point to. As a starting
point, this file might look like this:
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By making the font size large (I used 20), we can print this file and post it next
to the screen and use it for a quick reference. Okay, now let's save this file.
Because I figure we will want to modify this file every time we create a new
shortcut, I placed it in the C:\Data folder and named it Shortcuts so it would
be easy to find.
Now all we have to do whenever we want to update this file is double-click on
the WordPad icon we created and open the Shortcuts file. Neat, eh? Hey, wait
a minute. Might it be possible for us to do this all in one operation? Let's go
back in to the Properties for our icon again (right-click on the icon and select
Properties from the context sensitive menu). Notice that the Target: field
contains double-quotes around the full path to the file we are going to execute "C:\Program Files\Accessories\WORDPAD.EXE". I wonder if we can add
the name of the file we want to work with to the end of this. Let's try
expanding this field to - "C:\Program Files\Accessories\WORDPAD.EXE"
"Shortcuts.DOC". The reason for the double quotes around what we added is
that we don't want the system to alter this in any way. In addition, we didn't
specify the path to the file. Can you guess why? Think about this. Remember
the Start in: field? Isn't that where we placed this file? Sneaky, eh? ☺ If we
had placed this file somewhere else on the system, we would have needed to
tell the system where to find the file. Okay, time to give this another try to
make sure it does what we want. Double-click on the icon and see what
happens.

The PC Help Desk

103

7/7/04

I N T R O D U C T I O N

T O

W I N D O W S

9 8

With the change we've made to this icon, perhaps "WordPad" is not the best
name for it. Granted it brings up WordPad, but it also loads the file called
Shortcuts.DOC as well. Perhaps a better name for this icon would be "Edit
Shortcuts". To make this change, simply right-click on the icon and select
Rename and type in the new name. While you're at it, I suspect you don't want
to use <Ctrl><Alt>W as your hotkey any more. Perhaps <Ctrl><Alt>S would
be more appropriate. And don't forget to change your document as well.
For all of this, we've been working with a shortcut icon on the desktop. We
could just as easily do the same thing on the Start menu. To access what is on
the Start menu, click on Start, Settings and then Taskbar to get the Taskbar
Properties. Click on the Start Menu Programs tab at the top and then on
Advanced. This will give you a dialog box that looks very much like the
Windows Explorer except that it deals with the Start menu.

Diskettes
I can hear you now. A diskette is a diskette is a diskette. What can you say
about a diskette that I didn't learn a long time ago? Well, read on and you
might be surprised. There are actually two different kinds of diskettes and
some things you need to know about each. Let's take a look at each of these.
5 1/4" Diskettes
The 5 1/4 inch diskette dates back to the early days of personal computers. I
can remember my first personal computer having 5 1/4 inch diskettes (two of
them) and no hard drive. Back then, diskettes would hold 160KB worth of
data. This wasn't much, but without anything more, this was sufficient.
It wasn't too long before technology began to show its stuff. The 160KB
diskettes were doubled to 320KB, but at about the same time a change occurred
that allowed a little more data to be stored on a diskette giving a capacity of
360KB. This was a big improvement.
The next improvement came several years later and resulted in a capacity of
1.2MB. This is the maximum capacity of the 5 1/4 inch diskette
3 1/2" Diskettes
You probably already know that 3 1/2 inch diskettes come in two flavors 720KB and 1.44MB. The difference is very subtle and a lot of people won't
even notice it. If you look at a 720KB diskette and a 1.44MB diskette side-byside, you'll notice that the 720KB diskette has one window with a little tab.
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This is your write protect window and tab. The 1.44MB diskette has the same
thing, but the 1.44MB has another window in the other corner. Hmmm.... Is
that the only difference? For the most part, yes. The diskettes are
manufactured pretty much the same, but the 720KB diskette doesn't contain
this extra window. Well then, suppose you punched a hold in this location on
the 720KB diskette - would that make it a 1.44MB diskette? YES! You can
buy a single hole punch at the drug store and use it to punch the hold. After
you've punched the hold, reformat the diskette and the system will allow you to
do so at 1.44MB. You just doubled the amount of space available on the
diskette. Neat, eh? Learned anything new yet? ☺
I mentioned the write protect window and tab. Perhaps I should say a little
more about these. When looking at either a 720KB or a 1.44MB diskette, you
will see a little window that has a tab covering it. The tab can be slid to open
the window by turning the diskette over. As long as you cannot see through the
window, you can write to the diskette. If you want to protect your data so it
won’t get accidentally overwritten, simply open the window and nothing can be
written to the diskette again until you close the window.
Okay, try this. When you installed Windows 95, you may have had difficulty
finding enough space on your already crowded hard drive. If so, you may have
resorted to DriveSpace to make more room so you could install your new
operating system. Hey, this is great. You don't really need to buy another hard
drive after all. You now have all sorts of space. But.... There's always that
word. After you get Windows 95 up and running, you notice that your system
is really running slow. Well, that DriveSpace you installed does slow things
down primarily because you have to go through an extra level of software
before you get to the physical hard drive. Solution? Remove DriveSpace.
Yes, I know this means you have to go buy another hard drive, but better that
than to have your system running as slow as it is. Sorry about that. And I
know the title of this page is Diskettes. So what does this have to do with
diskettes? I just wanted to remind you of DriveSpace and what it can and can't
do.
Okay, let's apply this to your diskettes. If you take your 720KB diskette and
apply DriveSpace to it, you can increase the space available on it to 1.25MB.
Wow! That's almost as good a 1.44MB diskette. So what happens if you do
this to a 1.44MB diskette? You get 2.6MB. So, how do you accomplish this
miraculous thing. Well, in the Windows Explorer, right-click on a formatted
diskette. Click on the Compression tab and follow the bouncing ball to
increase the space on your diskettes.
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Okay, okay. There is a down side to this. Be careful about which diskettes you
compress. You don't want to compress diskettes you want to use to take
information to a Windows 3.x system as it won't work. I recommend you use
this technique on diskettes you want to use to store information from your
system that you don't need ready access to. Another problem is when you don't
want the diskette compressed any more. You can't simply format it to get it
back as Windows 95 recognizes that the diskette is compressed and won't allow
you to format it. What you have to do is use the DriveSpace utility to format it.
This doesn't do away with the compression though. You then have to tell
DriveSpace to uncompress the drive.
If you're willing to live with these problems, go ahead and enjoy the extra space
on your diskettes.
The following may be funny, but you might be surprised to know that I've
actually seen some of these:
Never leave diskettes in the drive, as the data can leak out of the disk and
corrode the inner mechanics of the drive. Diskettes should be rolled up and
stored in pencil holders.
Diskettes should be cleaned and waxed once a week. Microscopic metal
particles may be removed by waving a powerful magnet over the surface of the
disk. Any stubborn metal shavings can be removed with scouring powder and
steel wool. When waxing a diskette, make sure the surface is even. This will
allow the diskette to spin faster, resulting in better access time.
Do not fold diskettes unless they do not fit into the drive. "Big" Diskettes may
be folded and used in "Little" drives.
Never insert a diskette into the drive upside down. The data can fall off the
surface of the disk and jam the intricate mechanics of the drive.
Diskettes cannot be backed up by running them through a photo copy machine.
If your data is going to need to be backed up, simply insert TWO diskettes into
your drive. Whenever you update a document, the data will be written onto
both disks. A handy tip for more legible backup copies: Keep a container of
iron filings at your desk. When you need to make two copies, sprinkle iron
filings liberally between the diskettes before inserting them into the drive.
Diskettes should not be removed or inserted from the drive while the red light is
on or flashing. Doing so could result in smeared or possibly unreadable text.
Occasionally, the red light remains flashing in what is known as a "hung" or
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"hooked" state. If your system is hooking, you will probably need to insert a
few coins before being allowed to access the slot.
If your diskette is full and needs more storage space, remove the disk from the
drive and shake vigorously for two minutes. This will pack the data enough
(data compression) to allow for more storage. Be sure to cover all openings
with scotch tape to prevent loss of data.
Data access time may be greatly improved by cutting more holes in the diskette
jacket. This will provide more simultaneous access points to the disk.
Periodically spray diskettes with insecticide to prevent system bugs from
spreading....

Viruses
There are over 40,000 viruses out there in cyberspace just waiting to
infect your computer. And 200 new viruses are invented every
month. It only takes one virus to render your computer useless.
You have an anti-virus program. Are you protected? Maybe or
maybe not. If you aren't updating the program on a regular basis,
you could still be in trouble. Please read on.
Let me start off with a story. I recently received E-Mail from a couple who
said they purchased McAfee virus scan several years ago. They had version
2.0.5 and wanted my advice on what to do. Should they upgrade what they had
or should they just buy a new version. I recommended that they buy a new
version since McAfee has gone through several revisions since they bought
theirs and the cost is not all that great. They took my advice and bought the
latest version of McAfee and installed it on their computer. McAfee
immediately detected a virus on their system and told them it couldn't remove
the virus without deleting the file. They agreed. Another infected file was
detected and removed. And then another. Before too long, they realized they
were in big trouble and contacted me again. Because they already had a virus
on their system and it had spread throughout the system, there wasn't much I
could do remotely so I recommended they shut their computer down and call a
local computer person to come disinfect their computer and get them back up
and running.
Now, the cost of the McAfee virus scan is $49.95 as I write this. The cost of
having someone come out and disinfect a computer could be several hundred
dollars. Need I say more? Well, yes, I suppose I should say a few more words.
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Some people feel their computer will never be infected by a virus. I'm not sure
how they come to this conclusion. Perhaps they never get sick themselves.
They never have a cold and they don't get their flu shots each year. I don't
know, but if their computer ever comes in contact with another computer, they
are inviting a virus to infect it. By contact, I mean in any fashion. Perhaps
your friend gives you a diskette and suggests you try a piece of software. That
software could be infected and infect your computer. Or perhaps you go down
to the local computer store and buy the latest software for your computer. It
very well could be infected with a virus and infect your computer when you
install it. Or perhaps you enjoy getting on the Internet and looking around.
There are a lot of very nice things on the Internet - viruses included. Just by
browsing the Internet, your computer could become infected with a virus. If
you download anything to your computer, there is an even better chance that
you could catch something. Even if you don't intentionally download anything,
files are being transferred to your computer simply by the way you connect to
the Internet, and these files could contain a virus. In short, not having a virus
scan program on your computer is like having unprotected sex - you're asking
for trouble.
Okay. So I've convinced you that you need to protect your computer, and you
go to the computer store and buy a virus scan program (McAfee is just one of
several programs that will protect your computer). You're done, right? Well,
you've taken the first step. As I said earlier, in addition to there being over
40,000 viruses out there today there are some 200 new viruses invented every
month, and the software you bought last month will not protect you against the
new viruses that were invented this month. It can't because when they wrote
that program they didn't know about the new viruses. Most virus scan
programs today come with the ability to update what is called the signature file
which identifies the viruses and removes them. These updates are free in most
cases if you know how to get them. The key is that you need to make an effort
to keep your virus scan software up to date. If nothing else, you should contact
the company you bought your virus scan software from and ask them if there
are any updates.
I am most familiar with the McAfee virus scan program. I have been a
registered user of it for many years. McAfee has a shareware version of their
virus scan program that is available on a trial basis. It only costs you $49.95 to
get a registered version and the peace of mind you get with it is well worth the
investment. There's a catch though - the chicken or the egg story. If you
already have a virus on your system, the virus scan software may not be able to
help you. If you don't have a virus, why do you need a virus scan program?
Well, my recommendation is that you get yourself a virus scan program. If you
aren't already infected, you'll have the peace of mind knowing that you won't
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catch anything in the future. If you discover that you have a virus, you then
need to take steps to disinfect your system and do it as quickly as possible. The
longer you wait, the more damage the virus can cause. And once you're
protected, don't forget to keep it up to date. You need to get the latest software
as well as the latest signature file. Both are important.
One final word. THERE ARE NO GUARANTEES! Since there are some
200 new viruses invented every month, you can have all the protection in the
world and still catch a virus. This is unfortunate, but a fact of life. The key is
to protect yourself as best you can and hope that you don't catch one of those
new viruses before they come out with an update to detect it.
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